
1, 2, ... commands (Window menu)

EZ-Forms displays a list of currently open form windows at the bottom of the Window menu. A 
check mark appears in front of the form name of the active window. Choose a form from this list 
to make its window active.



1, 2, 3, 4 commands (File menu)

Numbers and file names listed near the bottom of the File menu list the last four forms you 
opened. Choose the number that corresponds to the form you want to open, or click on the 
name with the left mouse button.



ABS(num)
Description Returns the absolute value of a number. 

Syntax ABS(number)

number is any numeric value, including constants, numeric fields and numeric values.

Remarks An absolute value is always a positive number.

Examples ABS(-1) returns 1

ABS(1.2) returns 1.2



ACOS(num)
Description Returns the arc cosine of a number. 

Syntax ACOS(number)

number is the cosine of the angle. The cosine can range from 1 to -1.

Remarks The resulting angle is returned in radians (from 0 to pi).

See Also COS and PI functions

Examples ACOS(.5) returns 1.05

ACOS(-.2) returns 1.77



ASIN(num)
Description Returns the arcsine of a number.

Syntax ASIN(number)

number is the sine of the resulting angle, ranging from -1 to 1.

Remarks The resulting angle is returned in radians (ranging from -pi/2 to pi/2).

See Also PI and SIN functions

Examples ASIN(-1) returns -1.57

ASIN(.4) returns .41



ATAN(num)
Description Returns the arctangent of a number.

Syntax ATAN(number)

number is the tangent of the angle.

Remarks The resulting angle is returned in radians, ranging from -p/2 to p/2. To find the
result in degrees, multiply the result by 180/PI().

See Also ATAN2, PI and TAN functions

Examples ATAN(3.5) returns 1.29

ATAN(-4) returns -1.33



ATAN2(num,num)
Description Returns the arctangent of y/x.

Syntax ATAN2(x, y)

The x and y parameters can be any valid numbers.

Remarks Returns a value in the range -pi to pi radians. The ATAN2 function uses the 
signs of both parameters to determine the quadrant of the return value. The 
ATAN2 function is well defined for every point other than the origin, even if x 
equals 0 and y does not equal 0.

See Also ATAN, PI and TAN functions

Examples ATAN2(3, 6) returns 1.11

ATAN2(-1, .1) returns 0.1



About command (Help menu)

Displays the copyright notice and version number of your copy of EZ-Forms™.

EZ-Forms™    is    © 1994-97 by EZX Corporation, all USA and International 
rights reserved.

Distributed by:

EZX Corporation
“The EZ-Forms Automation Company”
917 Oakgrove Drive, Suite 101
Houston, TX      77058-3046      USA

Technical Support:
Voice: +1-281-280-0080 

(9:00am - 4:00pm    Central    USA    M - F)
Internet: support@ez-forms.com    or    

EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
World Wide Web: http://www.ez-forms.com

For all other business and International:
Voice: +1-281-280-9900 

(Questions, Comments, observations, & support.)
FAX: +1-281-280-0099 

(Inbound FAXes; 24hrs per day.)

• Credit Card Orders (Visa, MasterCard, Discover, American Express) at:
    Voice Order Desk: 1.800.800.2H4O6T8

 (toll free in the USA; support/service calls will incur a service charge))
    FAX Order Desk: 1.800.F3A2X9.2H4O6T8

 (toll free in the USA; All other correspondence, etc. will be ignored.)

(There is a per-minute charge for service/support calls to the above number.)



Arrange Icons command (Window menu)

Use this command to arrange icons for minimized windows at the bottom of the EZ-Forms main 
window. If there is an open form window covering the bottom of the main window, then some or 
all of the icons may not be visible because they will be behind this form window.



Brush command (Form menu)

Modify background/fill attributes for the selected object by using the Brush command in the 
Form menu or the object popup menu. This displays the Brush dialog box.



Brush command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Brush dialog box are used to set defaults for all 
newly created rectangle, rounded rectangle and ellipse objects. Existing objects are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Brush Dialog

Choose the background fill pattern and color for Rectangle, Rounded Rectangle and Ellipse 
objects. When accessed with the Options-Defaults-Brush menu, brush selections will only affect
newly created objects.

The brush characteristics of an object can be altered after placement by using the Form Brush 
command, accessible from the main menu or the object popup menu. The dialog box title will 
not include "Defaults" when modifying an existing object.

Style:
Available fill pattern design and shading effects for shaped objects are:
Cross Hatch
Diagonal Cross
Downward Hatch
Horizontal Hatch
Solid
Transparent
Upward Hatch
Vertical Hatch

Brush Color button
Access the Color dialog to choose from a given color set.



CEIL(num)
Description Rounds a number up to the nearest integer.

Syntax CEIL(number)

number is the value to round.

Remarks Returns the nearest integer value (whole number) greater than number.

See Also FLOOR function

Examples CEIL(1.23459) returns 2

CEIL(-148.24) returns -148



COS(num)
Description Returns the cosine of an angle.

Syntax COS(number)

number is the angle in radians, and can be any value.

See Also ACOS, COSH and PI functions

Examples COS(1.444) returns .126

COS(5) returns .28



COSH(num)
Description Returns the hyperbolic cosine of a number.

Syntax COSH(number)

number is the angle in radians, and can be any value.

See Also COS function

Examples COSH(2.10) returns 4.14

COSH(.24) returns 1.03



CTOD(char)
Description Converts Character to Date.

Syntax CTOD(char)

char is a character string representing a valid date in the current Windows International settings 
format.

Remarks Converts a character-type date representation into a date-type value.

See Also DATE, DTOC and DTOS functions

Example With Windows International settings of mm/dd/yy, CTOD("12/2/98") returns 
the date-type value of 12/2/98.



Calculate command (Field menu)

When a calculation exists for the current field, this command will process that calculation. A field
calculation is created by the form designer in order to make form fillout easier, quicker and more
accurate. Otherwise calculations would have to be carried out manually.

The calculation for the current field is automatically processed when the cursor is moved to the 
next field, so this command is only necessary when you don't want to move to the next field 
prior to seeing the results. This situation may arise when the next field is outside of the viewable
window.

Errors can occur during field calculation, such as divide by zero, underflow or invalid function 
parameters. Any errors will result in an error message displaying the expression and the field 
name of occurrence.

Shortcut
Toolbar:



Cascade command (Window menu)

Use this command to arrange multiple open windows in an overlapped fashion.



Change Graphic (Edit menu)

Graphic images that were inserted using either the Edit Insert Graphic or File Scanner Acquire 
commands can be modified with this command.

An open file dialog is presented to allow selection of the new graphic file. The linked or 
embedded nature of the graphic will remain the same.

To convert linked to embedded or vice versa, the image must be deleted and then reinserted.



Clear All (Edit menu)

Design Mode
This provides a quick and convenient way to clear all objects in a form. Prompts for confirmation
first. The resulting form is blank, identical to the blank form created by the File-New command.

Fillout Mode
This provides a quick and convenient way to clear the contents of all fields in a form. Prompts 
for confirmation first. The resulting form has all blank fields.

See Also

Edit Fillout Next



Close command (Control menus)

Use this command to close the active window or dialog box.
Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open, the Close command on the form Control menu 
closes only one window at a time. You can close all windows at once with the Close-All 
command in the Window menu.

Shortcut
Keys: Ctrl + F4 Close a form window.

Alt + F4 Close a dialog box



Close command (File menu)

Use this command to close an active form window. When the form is modified, a save prompt 
will appear. If you close a modified form without saving it, you lose all changes made since the 
last time you saved it. Before closing an untitled form, EZ-Forms displays the Save As dialog 
box and suggests that you name and save the form.

You can also close a form by double-clicking the Close icon on the form's window, as shown 
below:



Close All command (Window menu)

Use this command to close all open windows including those that have been iconized. You will 
be asked if you want to save any unsaved forms before closing them.



Color Dialog

Use this dialog box to add color to your form's text, lines, boxes, etc.

Basic Colors
The current color selection is indicated by the shadowed box.
To select a new color, click on the color with the mouse or move the shadowed box with the 
arrow keys. If you chose a color for Text & Field Edit Background you may find that your choice 
is not activated. Select a brighter color than the one you just chose and refer to the 
troubleshooting section.

Custom Colors
This feature is unsupported by EZ-Forms.



Constants
Constants are fixed values of any type, specified in an expression. Field contents are 
automatically converted to the field type.

Character
Character constants are letters with quote marks around them. A single (') or double (") quote 
can be used, but be sure to use the same one on both sides of the constant. "Ed", 'Eduardo' 
and "15515" are all examples of Character constants. If you wish to specify a character constant
with a single quote or a double quote contained inside it, use the other type of quote to mark the
Character constant. For example, "Andy's" and '"OK"' are both legitimate Character constants.

Numeric
A Numeric constant represents a specific numeric value. For example, 7, 82, 2.35 and 22 are all
Numeric constants. EZ-Forms supports numbers of 15 significant digits, with a variable 
exponent. To enter an exponent, follow the number with an 'E' and then the number 
representing the exponent. For example, 2.142E3 represents 2142.

A valid number consists of a sign (+/-) followed by whole number digits and fractional digits 
separated by a decimal point (.). An optional exponent can follow, which is preceded with 'E' and
followed by an optional sign and then the exponent value. Here is a more pictorial 
representation:

{sign}{whole number digits}{.}{fractional digits}{E}{sign}{exponent}

The MINVAL, MAXVAL, MINEXP and MAXEXP functions return the corresponding numerical 
limits of EZ-Forms.

Logical
A Logical constant can only be '.TRUE.' or '.FALSE.'. '.T.' and '.F.' are legitimate abbreviations. 
The '.' is used to distinguish it from a field name. In a logical field, yes, no, true, false and their 
single-letter abbreviations are the only values allowed.

Date
A Date constant must be specified using the String to Date function STOD which converts a 
format-independant character string into a date value. It is also possible to use the Character to 
Date function CTOD, but the date character string must match the current Windows 
International settings, accessible from the Windows Control Panel. Since these settings can 
change at any time and can differ on another computer, this method is not recommended.

For example, February 5th, 1998 would be specified as STOD('19980205'). In a date field, the 
characters representing the date are automatically converted.



 EZ-Forms XL/PRO      
The Professional Eforms Processor for Windows 95/NT/3.1x.

“Eforms”, Math, Pick/Help-Lists, Pop-Ups, Field Ordering, Multi-Pages, More!
Create, Modify, Scan, Fill-In, Navigate, Compute, Validate, Save, ANYFORM™
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EZ-Forms XL/PRO™ & © 1994-97 by
 EZX Corporation
“The EZ-Forms™ Automation Company”

 

Introduction
Installation
Getting Started
Overview
What's New
FAQ      (Frequently Asked Questions)
How To . . .
Troubleshooting
Keyboard Commands
Error and Warning Messages
License
Tutorial      (may not be available with the Shareware/TestDrive or Fill Only Edition)

Thank you for using EZ-Forms™ for Windows © 1994-97 by and from:    (All rights 
reserved.)

NOTE: The EZ-Forms™ (XL, PRO, ODBC) product line for Windows 
was previously named the FormPower™ series.      ( FormPower/PRO, 
HotForms/PRO, FormEZ, FormIT, SuperForms )
For more information, contact EZX Corporation at +1-281-280-9900    
FAX: +1-281-280-0099.

This EZ-Forms release is "32 Bit" only. It will
operate properly under Windows 95 and Windows NT.
Win95 requires 16MB. Windows NT requires 32MB.
It will also operate under Windows 3.1x with
"Win32s" installed and 16MB minimum RAM.

NOTICE TO WINDOWS 3.1x USERS:
Windows 3.1x users must install the latest
"Win32s" before installing this program.
Win32s are available from MicroSoft
Corporation's Web Site. The URL address is:



http://www.microsoft.com 
After connecting to their site, click on Search
and enter    Win32s    at the prompt. Download and
install the Win32s before installing this program.
-The latest URLs we have are:
http://www.microsoft.com/kb/articles/q122/2/35.htm
This gives a download link and installation
instructions.
-URL for download of Win32s
(Feb. 22 1996 Release is the latest.)
http://www.microsoft.com/kb/softlib/mslfiles/Pw1118.exe

EZX Corporation
“The EZ-Forms Automation Company”
917 Oakgrove Drive, Suite 101
Houston, TX      77058-3046      USA

Technical Support:
Voice: +1-281-280-0080 

(9:00am - 4:00pm    Central    USA    M - F)
Internet: support@ez-forms.com    or    

EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
World Wide Web: http://www.ez-forms.com

For all other business and International:
Voice: +1-281-280-9900 

(Questions, Comments, observations, & support.)
FAX: +1-281-280-0099 

(Inbound FAXes; 24hrs per day.)

P.S. Our area code changed recently (Nov. 2, '96) from 713 to 281. It has come to our 
attention that some telephone central offices are not yet programmed to recognize this 
new style area code. If you have problems getting through, try area code 713 which will 
be "permissive" through April '97.

For more information, contact EZX Corporation at +1-281-280-9900    FAX: +1-281-280-0099.

Special versions of EZ-Forms (using the EZ-Forms PRO Filler engine) specifically tied to 
custom developed forms, are the “engines” that drive products like ExportPower PRO™, 
WinDD250 PRO™, FormTrooper™, EZ-MSDS™, PackageTrakker™, YourForms PRO™, 
WinSF171™, AnyPower™, MedTrakker™, ExpenseTrakker™, etc. Call for details.

Should you require a special re-distributeable edition of EZ-Forms XL, it is known as EZ-Forms 
PRO and is available in Site, Corporate, and Developer's editions.



* Call for Multi-user, LAN, Server, Site,
    Corporate and Developer's licensing and
    extended support. (EZ-Forms PRO)

Ask about upgrade, competitive, and introductory pricing.

Also ask about custom design and “sub-publishing” services.

Specifications, pricing, etc. are subject to change without notice.

Copyright © 1994-97 EZX.          970610 All rights reserved.



Control menu (Form window)

The main EZ-Forms window and the Form and Dialog box windows all have a control menu tab 
in the top left corner. Double-clicking on the tab is the same as selecting Close from the menu.

Restore Restores the window.
Move Repositions the window.
Size Adjust the window size.

Minimize Iconize the window.
Maximize Expand the window.

Close Closes the window.
Next From control tab.

Switch to another open form within EZ-Forms.



Control menu (Main window)

Top Left tab on Program, Form and Dialog box windows. Double-clicking on the tab is the same 
as selecting Close from the menu. Double-click on the Control tab, or use key combination Alt + 
F4 to close the program window, or any displayed dialog boxes.

Restore Restores the window.
Move Repositions the window.
Size Adjust the window size.

Minimize Iconize the window.
Maximize Expand the window.

Close Closes the window.
Switch To Program control tab.

Switches to another program.



Copy command (Edit menu)

Use this command to copy the currently selected (highlighted) object or text from the form and 
put it into Windows' clipboard. The Paste command can then be used to copy the clipboard 
contents to another form, or to elsewhere on the same form.

This command is unavailable if no object or text is selected.

Copying data to the Windows clipboard always replaces any previously stored contents.

Shortcut
Toolbar:
Keys: Ctrl + C



Cut command (Edit menu)

Use this command to remove the currently selected (highlighted) object or text from the form 
and put it into Windows' clipboard. The Paste command can then be used to copy the clipboard 
contents to another form, or to elsewhere on the same form.

This command is unavailable if no object or text is selected.

Cutting data to Windows' clipboard always replaces any previously stored contents.

Shortcut
Toolbar:
Keys: Ctrl + X



DATE()
Description Returns today's date.

Syntax DATE()

Remarks Returns today's date as a date value.

See Also CTOD, DTOC and DTOS functions



DTOC(date)
Description Convert Date to Character.

Syntax DTOC(date)

Remarks The Date to Character function converts a date value into a character value. 
The format of the character string is controlled by the Windows International 
settings.

See Also CTOD, DATE and DTOS functions

Example DTOC(DATE()) returns the character value "12/19/95" if the date is December
19, 1995, and Windows International settings date format is MM/DD/YY.



DTOS(date)
Description Converts Date to String.

Syntax DTOS(date)

date is any valid date value.

Remarks The Date to String function converts a date value into a format-independant 
character value. The format of the resulting character string is 
"CCYYMMDD".Use DTOS whenever specifying a constant date value in an 
expression, since the value and format will not depend on the Windows 
International settings which can change at any time.

See Also STOD, CTOD, DATE and DTOC functions

Example DTOS(DATE()) returns the character value "19951219" if the date is 
December 19, 1995.



Text Feed-Date (Edit menu) & Date (Field menu)

Quickly insert system Date into a field during data entry using Ctrl + D. Any text that may 
already be in the field will be overwritten. You will not be able to insert into the middle of a 
sentence or phrase.

The format for Text Feed Date is controlled by the Windows' Control Panel International 
settings. The date format dd/MMM/yy is converted to display only numbers in order to provide 
calculation capability.

Shortcut
Toolbar:
 Keys: Ctrl + D



Delete Command (Edit menu)

Use the Del key, or the Edit-Delete command to delete the currently selected object from the 
form.

While entering text in design mode or during fillout mode, this command will delete selected text
or the character to the right of the cursor.



Delete Page (Form menu)

Removes the current page from the set of pages associated as on set in the form file.

See Also

Insert Page



Design Mode Overview
Click on an area of the dialog box for further explanation.



Troubleshooting: Divide by Zero Error
field001 is set as numeric with 2 decimal places, no formula

field002 is set as numeric with 2 decimal places, no formula

field003 is set as numeric with 2 decimal places, no formula

field004 is set as numeric with 2 decimal places, formula reads
        field001+field002+field003
        
field005 is set as numeric with 0 decimal places, no formula

field006 is set as numeric with 2 decimal places, formula reads
        iif(field005=0,0,field004/(field005+.00001))

The formula above is used to force the calculation to use something other than a zero. With the 
field options set to have two decimal places, the calculation will truncate the ".00001" value to a 
number that will not be displayed because of the two decimal point limitation.



Duplicating information in subsequent fields.
Question:
Does EZ-Forms allow you to enter data in one field on the first page and then when printing out 
the whole stack of pages it automatically fill the information in the same field on all pages?

Answer:
Yes it does. It is done by inserting a "logical formula" in the field properties and subsequent 
pages.

Your solution is:    If field001 is a number or text entry field, and field099 is the field you want to 
contain the same information as field001, simply make field099 a calculated field (with other 
parameters properly set). Set field099's only calculation formula as "field001" without the "". So, 
when field099 is passed by in the fillout sequence (or form is saved, or printed), field099 will 
contain the same information as field001. Pretty neat, eh? You can do this umpteen times per 
page and even do other math if you wish. This technique works great with auto-number and 
auto-date fields too. So, you need only one auto number field per form file and you can 
duplicate its contents in any field, on any page of your form as often as you wish.

For an example of how this works in practice, download the TestDrive edition of ExportPower 
PRO or EZ-MSDS. You won't be able to modify the form design, but you'll see data from page 2 
automatically plugged in to following pages.



E()
Description Returns the value of the e mathematical constant.

Syntax E()

See Also EXP and LOGN functions



EXP(num)
Description Returns e raised to the specified power. The constant e is 2.718281828... (the 
base of the natural logarithm).

Syntax EXP(number)

number is the exponent and can be any number.

See Also LOG10 , LOGN    and E functions

Examples EXP(2.5) returns 12.18

EXP(3) returns 20.09



EZ-Forms PRO      
 

• Allows you to distribute Eforms you create and a “filler engine” to anyone
at your site without additional charges, Fees or royalties.

• The Ultimate Eforms Designer/Filler/Processor for Windows 95 and 3.1!
• Fill-in AnyForm™ quickly and easily!

• Create, Modify, Fill-in (internal), Fill-out(pre-printed), Navigate, Compute
(math and logical), Validate (check limits), Save ANY FORM™ in minutes!

 

 QUESTION:    Are you a serious hacker, developer,
MIS professional, or visionary who would like to
create Windows based Eforms for your clients, em-
ployees, co-workers, friends, etc., and be able to
re-distribute without copyright fees or royalties?
 

 With EZ-Forms PRO, you will!
 

 Prerequisites:    The ONLY ability you need to be-
come an Eforms professional is to be able to de-
sign or scan forms. If you are already familiar with
Windows word processors, DTPs and/or spread- 
sheets, your first form will take less tahn an hour.
 

 For example:    Lets say you have a field sales force
with laptops, and you want each sales person to be
able to FAX or Email their orders back to the home
office. No problem ... just create a master fill-out
form with EZ-Forms Pro Designer and give the form
along with EZ-Forms PRO Filler to each of them. All
they have to do is run the EZ-Forms PRO Filler and
File-Open the form to immediately fill it out.
 

 Or, you might want to create field surveys, police
reports, whatever. The applications are endless.
 

 You own custom coded version of EZ-Forms PRO
Designer, which will create and/or revise only your
master forms.
 

 A custom coded version of EZ-Forms PRO Filler
which you will be able to distribute to anyone at your
site. EZ-Forms PRO Filler is self-installing. All you'll
need to do is run “SETUP.EXE” from a distribution
diskette or hard drive directory/folder. You will be 
authorized to make unlimited copies of this custom
“runtime engine” of EZ-Forms PRO Filler.
 

You can even “distribute” your Eforms and custom
filler engine via the Internet/Intranet or BBS. Must be
site related unless you have the Corporate or
Developer's Edition.
 

 

 Custom coding of the Designer and Filler assures
that no one else (even EZ-Forms PRO licenees)
can modify your forms, thus protecting the
integraty of you masters.
 

 Simply open any Eform you create in the EZ-Forms
PRO Filler engine, and you have a custom
“application”. Depending on their complexity many
forms can fit on a single diskette for distribution.
Compression (.ZIP) can add even more.
 

 OtherEZ-Forms PRO licensee benefits include:
Reduced price applications development and design
cunsulting. Onea year of free voice technical support.
Per incident and extended service contracts are
available. Unlimited BBS/Email support is also included.
 

 If you do not wish to develop your own Eforms,
EZX'S design staff can do it for you. Simple FAX or
mail us a copy of your forms for a prompt custom
design quotation.
 

 NOTE: For a complete description of the code- cust-
omized EZ-Forms PRO Designer (Master Forms Editor),
see the EZ-Forms PRO Designer brochure, on a
separate page. EZ-Forms PRO Designer IS NOT
licensed for re-distribution. EZ-Forms PRO Designer
creates the coded master form template(s) that will
be used with EZ-Forms PRO Filler for fill-in or fill-out.
EZ-Forms PRO Filler IS licensed for re-distribution on
your site. You must however include at least one
customized form.
 

 EZ-Forms PRO includes:    Site License for EZ-Forms PRO 
Filler “filler engine”. EZ-Forms PRO Filler is a Network Ready, 
Multi-User    “LAN” Edition. Also includes EZ-Forms PRO 
Designer (single user edition).
Call/FAX for Corporate and Developer licensing.
 

EZX Corp. “The EZ-Forms Automation Company”
Voice: +1-281-280•9900      Web: http://www.ez-forms.com

Fax: +1-281-280•0099      Email: ezformspro@ez-forms.com

EZX Corp.  “The EZ-Forms Automation Company”  917 Oakgrove Dr., Ste 101, Houston TX 7058-3046
V/MC/D/N/Ax accepted. (Specifications, prricing, etc. are subject to change without notice.)    ©1997-FPR    Internet World Wide Web: http//www.ez-forms.com 



EZX's Special Purpose Eforms Automation Products 
Include:
When you are connected to the internet with your web browse running copy any of the following 
URL's to your browser's link address line. Although the use of    “www.” in the URL line will 
access our web pages, it is not required.

EZX Corporation
“The EZ-Forms Automation Company”

http://ez-forms.com/

• EZ-Forms PRO -- Enterprise Solution for Eforms Automation. Includes Single user designer 
and unlimited user filler. Available in site, corporate and developer editions. Win95/3.1x

http://ez-forms.com/ezfrmpro.htm

• EZ-Forms XL -- The exectutive Electronic Forms Processor. Creates, fills, prints, any form.
Available in single user edition only. Win95/3.1x

http://ez-forms.com/ezfxl.htm

• ExportPower PRO -- Fills, prints, manages export documentation.
Available in site and corporate editions. Win95/3.1x

http://ez-forms.com/exportpr.htm

• EZ-MSDS -- Eforms processing for Material Safety Data Sheets.
Available in site and corporate editions. Win95/3.1x

http://ez-forms.com/ezmsds.htm

• WinDD250 PRO    -- Fills,    prints, manages the USA Department of Defense's    Material 
Inspection and Receiving Reports (DD250 & DD250c)
Available in site and corporate editions. Win95/3.1x

http://ez-forms.com/dd250p.htm

• FormTrooper -- Fills, prints, manages, Law Enforcement Related Forms
Available in site and corporate editions. Win95/3.1x

http://ez-forms.com/frmtroop.htm

§    Additional Web pages you may want to access directly.
• EZ-Forms Design Services

http://ez-forms.com/ezfdesgn.htm

• Technical Support Web Form
http://ez-forms.com/techsup.htm

• Fregently Asked Questions
http://ez-forms.com/faq.htm

• EZ-Forms News Letter
http://ez-forms.com/newsletter.htm



• EZ-Forms Press Release
http://ez-forms.com/pressrelease.htm

EZX Corporation
“The EZ-Forms Automation Company”
917 Oakgrove Drive, Suite 101
Houston, TX      77058-3046      USA

Technical Support:
Voice: +1-281-280-0080 

(9:00am - 4:00pm    Central    USA    M - F)
Internet: ezforms@ez-forms.com    or    

EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
World Wide Web: http://www.ez-forms.com

For all other business and International:
Voice: +1-281-280-9900 

(Questions, Comments, observations, & support.)
FAX: +1-281-280-0099 

(Inbound FAXes; 24hrs per day.)



Ellipse command (Draw menu)

Ellipse Drawing tool. Activate by clicking on the Ellipse Toolbar button, or by selecting the Draw-
Ellipse command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing an ellipse to
the desired size.
3) Release the mouse button when done.

When the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's 
corner points will "snap" to the nearest grid points.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Error and Warning Messages
Select one of the following error or warning message topics. Each will specify whether it applies 
to design mode, fillout mode, or both. Where possible, remedies are given.

Server is still busy.

There are no fields in this form. Fillout cancelled.

Save option settings?

Save this form before continuing.

Are you sure you want to clear the entire form?

Cut to clipboard failed.

Copy to clipboard failed.

Failed to paste object from clipboard.

Failed to create object.

Item on the clipboard has zero size.

Failed to initialize OLE2 libraries.

Error loading EZX1.DLL

Error opening graphic file

This single-user version of EZ-Forms cannot access network drives. Please contact EZX for 
network pricing information.

This single-user version of EZ-Forms cannot run from a network drive. Please contact EZX for 
network pricing information.

Error setting system timer.

The EZ-Forms executable file exhibits evidence of tampering. Unable to continue. Reinstall from
original disks.

Please enter a number between .02 and 25.4 cm.

Please enter a number between .05 and 2.54 cm.

Please enter a number between 5.08 and 76.2 cm.

Calculation yields invalid date.

Calculation yields a number that is too small or too large.



Error in calculation.

Test OK. The expression result is of type: ??.

Test OK. The expression has a Logical type result.

Error: the validate expression does not evaluate to a Logical type value (for example, qty<100). 
Furthermore in fillout, the result must be True.

Current field does not pass designer validation criteria.

Invalid field name. Characters in name must be alphanumeric or _.

Calculation results in a type that does not match field.

The form orientation does not match the printer orientation setting. Continue printing?

Invalid date value.

Error reading auto number file.

Invalid number and/or format.

Error reading pick list file.

Error reading field help file.

The help file is too long. Truncating view.

Linking to a graphic file will only save the file path name in the form.    This requires ...

Create new auto number file ?, starting with a value of 1.

Unable to activate the TWAIN source.    Make sure ...

TWAIN error.

Error creating graphic file ?.

Error drawing graphic.    The original image is ...

Unable to find the linked graphic file ?.    If this form was copied ...

Unable to find the linked graphic file ?.    If this form was copied ...

Error updating OLE object from server.    Possible out of memory condition.

Error writing auto number file ?.

Error reading graphic file ?.



Error writing graphic file ?.

TWAIN initialization failed.    Make sure TWAIN is properly installed.

Error: Duplicate field name.

Error creating export file

Error writing to export file

Error opening import file

Error reading import file

Error interpreting import file ?.



Error creating export file
An error has occurred creating the export data file. Check that the directory you want to save 
this file in does exist. Also try saving to a filename that conforms to the standard eight+three 
characters file naming convention.

NOTE:    The single user version will not access, write to or read from a network drive.

See Also

How To Use Command Line Options



Error creating graphic file ?.
Design mode

A system error occurred when creating the file that a graphic is to be written to.

Remedy

Check the following possibilities:
1) Too many files in the destination directory.
2) No creation rights for directory, if network drive.
3) Insufficient system file handles.



Error drawing graphic. The original image is ...
Image complexity or size is preventing proper display.

Remedies

Convert graphic to black and white, if not already.

Close other applications.

Convert graphic to a smaller size.



Error in calculation.
The calculation for the current field cannot be processed. This can be caused by invalid inputs 
or a flawed expression.

See Also

Expressions



Error interpreting import file ?.
All fields must begin and end with double quotes(" "). The end quote for a multi-line field must 
only appear on the last line of the field.



Error loading EZX1.DLL
This file is required for the operation of EZ-Forms. It should be located in your program 
subdirectory.

See Installation for a listing of program files required by EZ-Forms.



Error opening graphic file
File format may not be supported by Windows or EZ-Forms. If accessing file over a network, it 
may be in exclusive or restricted use by another client.



Error opening import file
An error has occurred opening the import data file. Check that the directory you want to open 
this file from does exist. Also try opening from a filename that conforms to the standard 
eight+three characters file naming convention.

NOTE:    The single user version will not access, write to or read from a network drive.

See Also

How To Use Command Line Options



Error reading auto number file.
An auto number file was specified by the form designer, but it cannot be found or accessed. 
Unless the full path was given, auto number files must reside in the same directory as the form 
file itself.

See Also

Troubleshooting:



Error reading field help file.
A field help file was specified by the form designer, but it cannot be found or accessed. Unless 
the full path was given, field help files must reside in the same directory as the form file itself.

See Also

Troubleshooting:



Error reading graphic file
File format may not be supported by Windows or EZ-Forms. If accessing file over a network, it 
may be in exclusive or restricted use by another client.



Error reading import file
An error has occurred reading the import data file. Check that the directory you want to read this
file from does exist. Also try reading from a filename that conforms to the standard eight+three 
characters file naming convention.

NOTE:    The single user version will not access, write to or read from a network drive.

See Also

How To Use Command Line Options



Error reading pick list file.
A pick list file was specified by the form designer, but it cannot be found or accessed. Unless the
full path was given, pick list files must reside in the same directory as the form file itself.

See Also

Troubleshooting:



Error setting system timer.
Windows has apparently lost critical synchronization. Please save and close all applications, as 
well as Windows.

Remedy

Reboot your computer and restart Windows.



Error updating OLE object from server.    Possible out of 
memory condition.
Unable to complete and OLE object insert or display.

Remedies

Close other applications.

Reinstall OLE server application.



Error writing auto number file ?.
Fillout mode

The designer of the current form has used the auto number feature in at least one data entry 
field. When saving this form after filling it out, the auto number field must write a new number to 
the auto number file so the next form will have a new number to use.

Remedy

Check the following possibilities:
1) Too many files in the destination directory.
2) No creation rights for directory, if network drive.
3) Insufficient system file handles.
4) Insufficient disk space.



Error writing graphic file ?.
Design mode

A graphic file needs to be written, probably as the result of a scan from a scanner using the File 
Scanner Acquire command.

Remedy

Check the following possibilities:
1) Too many files in the destination directory.
2) No creation rights for directory, if network drive.
3) Insufficient system file handles.
4) Insufficient disk space.



Error writing to export file
An error has occurred writing to the export data file. Check that the directory you want to save 
this file in does exist. Also try saving to a filename that conforms to the standard eight+three 
characters file naming convention.

NOTE:    The single user version will not access, write to or read from a network drive.

See Also

How To Use Command Line Options



Calculation yields invalid date.
The date calculation for the current field results in a date that is not valid.

See Also

Expressions



Copy to clipboard failed.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



Create new auto number file ?, starting with a value of 1.
Fillout mode

When a specified auto number file does not exist, EZ-Forms will create it when necessary.



Current field does not pass designer validation criteria.
Fillout mode

This is the default error message given when a field's contents does not pass field validation. 
The form designer sets up the field validation criteria.



Cut to clipboard failed.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



A field with this name already exists. Field names must be 
unique.
Design mode

Some other field in this form already has this name. Field names must be unique in order to 
ensure unambiguous calculations and validations.



The EZ-Forms executable file exhibits evidence of 
tampering. Unable to continue. Reinstall from original 
disks.
This error could occur after a system crash, unexpected power interruption, compression 
corruption, software virus attack, as well as many other sources. The program is no longer 
usable and must be reinstalled. The executable file has been corrupted. Copy your master 
forms (.FRM) and filled out forms (.FOF) to a secure floppy. Remove the EZ-Forms icons and 
group from Windows. Delete all other files relating to EZ-Forms. Then reinstall.

When reinstalling EZ-Forms, make sure the distribution disks are write protected. If a virus is 
suspected, run one of the many available anti-virus programs for a diagnosis.

Note: All EZX/SSW programs are virus free when shipped from EZX. As we have no control of 
their handling after leaving EZX, we disclaim all responsibility for same.



Failed to create object.
Design mode

The object type may not be assigned in the Windows registry profile (REG.DAT). You may need 
to edit the REG.DAT file via the Windows program REGEDIT.EXE.

Remedy

Reinstall the application needed to create the object you need.

Or, use REGEDIT.EXE to verify proper entries for this object type. Refer to Windows technical 
documentation.

Caution: Consult an experienced Windows user or consultant before attempting this. EZ-Forms
automatically installs itself in the registry with the installation routines provided on the 
distribution disks. If you did not use the SETUP program provided with EZ-Forms, the registry 
will not have been updated. Reinstall the proper way. Other programs may not automatically 
update the registry. Consult their respective publishers or distributors for help.



Failed to initialize OLE2 libraries.
Appropriate object linking and embedding files are not available.

Remedies

1) Look for multiple copies of any .dll file that start with "ole". There should only be one copy of 
any particular ole file on your system. Look in both your windows and windows\system 
directories for duplicate ole files. All ole*.dll files should be in the windows\system directory only.
If you are still experiencing this problem, continuing looking for duplicate dll's in directories 
specified in your DOS PATH environment variable.

2) Reinstall the application.



Failed to paste object from clipboard.
There may be too many open programs in Windows to complete the action. System resources 
may be low.

Remedy

Try shutting down some applications and then retry this action.



The text in help file ?? is longer than 1000 characters. 
Truncating view.
Field help text is limited to 1000 characters. When a field help file contains too much text, the 
extra is ignored.

Remedy

Edit the help file and remove all text beyond the first 1000 characters.



Invalid field name. Characters in name must be 
alphanumeric or _.
Design mode

Field names can only contain alphabetic or numeric characters or the underscore.

Valid Examples:

field001
country
phone_num

Invalid Examples:

field 001
>country
phone*num



Invalid date value.
When entering dates, the format must match what was specified in the Windows International 
Settings. These can be viewed or modified via the Windows Control Panel.

This error will also result when an invalid day, month or year is specified.

See Also

Constants



Invalid number and/or format.
Number Format:

{sign}{whole number digits}{.}{fractional digits}{E}{sign}{exponent}

See Numeric Constants for more information regarding valid numbers.



Item on the clipboard has zero size.
The contents of the clipboard has been corrupted.

Remedy

Try pasting the original again. Make sure there are no programs running that deal with intensive 
tasks such as a spreadsheet recalculation, or image rendering. Processes that use a lot of 
computer or Windows system resources may restrict other program operations.



Linking to a graphic file will only save the file path name in 
the form.    This requires ...
A choice must be made that affects how a graphic placed in the form. There are two 
possibilities.

See Also

Edit Insert Graphic



Please enter a number between .02 and 25.4 cm.
Design mode

You must enter the number within the given range.



Please enter a number between .05 and 2.54 cm.
Design mode

You must enter the number within the given range.



Please enter a number between 5.08 and 76.2 cm.
Design mode

You must enter the number within the given range.



This single-user version of EZ-Forms cannot access 
network drives. Please contact EZX/SSW for details on 
the network versions of EZ-Forms and pricing information.
Please contact EZX/SSW at +1.281.280.9900 (FAX: +1.281.280.0099) with your requirements, 
and we will forward a custom quotation addressing your particular network needs.



This single-user version of EZ-Forms cannot run from a 
network drive. Please contact EZX/SSW for details on the 
network versions of EZ-Forms and pricing information.
Please contact EZX/SSW at +1.281.280.9900 (FAX: +1.281.280.0099) with your requirements, 
and we will forward a custom quotation addressing your particular network needs.



Calculation yields a number that is too small or too large.
The numeric calculation for the current field results in a number that cannot be represented or 
displayed.

See Also

Constants and MINVAL, MAXVAL, MINEXP and MAXEXP functions.



Calculation results in a type that does not match field.
The results of a calculation must match the type of the field it is for.

See Also

Expressions



Server is still busy.
EZ-Forms is currently processing an OLE function and the attempted operation is unsupported 
in this mode.

Remedy

Wait for the OLE function to complete.



TWAIN error.
An undeterminable error has occurred while attempting TWAIN initialization.

Remedy

Refer to your scanner documentation.

See Also

Installation



TWAIN initialization failed.    Make sure TWAIN is properly 
installed.
A TWAIN installation problem was detected during TWAIN initialization.

Remedy

Refer to your scanner documentation.

See Also

Installation



The graphic image is too large.
Image complexity or size is preventing proper display.

Remedies

Convert graphic to black and white, if not already.

Close other applications.

Convert graphic to a smaller size.



There are no fields in this form. Fillout cancelled.
Design mode

To fill out a master form, it must either be loaded with the File Fillout command or converted by 
using the Edit Fillout command. In either case, if no fillout fields exist in the master form, fillout 
cannot proceed and this message will result.

Remedy

Use the Field drawing tool to create fields on the form.



Unable to activate the TWAIN source.    Make sure ...
There is a problem with the selected TWAIN source.

Remedies

Select another scanner if available.

Refer to your scanner documentation.

See Also

Installation



Unable to find the linked graphic file ?.    If this form was 
copied ...
When a form is opened, all linked graphic files must be accessible. If the graphic originally 
resided in a directory other than where the form was saved, then the graphic file name in the 
form will include the entire path to the form, i.e., it will include the directory and file names.

Remedies

• Verify that graphic files reside in original locations
• Edit the master form and change the graphic file or location



Error: the validate expression does not evaluate to a 
Logical type value (for example, qty<100). Furthermore in 
fillout, the result must be True.
Design mode

When testing a validate expression during form design, this message will result when the 
expression does not evaluate to a Logical type.

See Also

Expressions



Exit command (File menu)

Use this command to end your EZ-Forms session. You can also use the Close command on the
EZ-Forms Control menu. EZ-Forms prompts you to save forms with unsaved changes.

Shortcut
Mouse: Double-click EZ-Forms's Control menu button.



Export (File menu)      This feature is available in EZ-Forms PRO, ExportPower PRO, WinDD250 PRO, 
EZ-MSDS and FormTrooper.
It is not an available feature in EZ-Forms XL

/X
Export data from the form indicated with the /F parameter.
The data in a completed from is extracted and stored in an ASCII file (.dta extension) with the 
first field's information surrounded by double-quotes on the first line which terminates with a 
carriage return and line feed. The second field's quotation delimited information is placed on the 
second line, etc. Data is export in field order, as set during form creation. A different ASCII text 
file will be generated from each Filled Out Form (.fof).
NOTE:    Multi-line fields do not work in this release.

For additional information, other parameters and example usage see Hot To Use Command 
Line Options.



Expressions
EZ-Forms field calculations and validations are specified via expressions. All expressions have 
the same structure, no matter where they are used They consist of combinations of field names,
operators, functions and/or constants. All expressions evaluate to a Logical, Character, Numeric
or Date type. Logical expressions have a True or False result and are used for field validation or
in the IIF function. A field calculation can have any result type, as long it matches its field type. 
Evaluation to a specific type means that all parts of the expression, whether they be fields, 
functions or constants, must be appropriately combined to yield any one type. Any improperly 
mixed types will cause an error. A common form of an expression is the name of a field. In this 
case, the type of the expression is the type of the field.

Constants
Constants are fixed values of any type, specified in an expression.

Field names
The presence of a field name in an expression will cause the contents of that field to replace the
field name in the expression. The contents are automatically converted into a value that 
matches the type of the field. Within expressions, constants and field names are generally 
interchangeable.

Operators
Operators can relate one part of an expression to another (>, =), or they can combine parts of 
an expression through a mathematical process (+, -). The result of a relationship is 
either .TRUE. or .FALSE.. The result of a mathematical process can be a value of any type.

Functions
Functions can be used as an expression or as part of an expression and always return a value. 
Functions always have a name and are followed by a left and right parenthesis. Values 
(parameters) may be required inside the parenthesis.

Dates and Numbers
Dates and numbers can be added and subtracted. This is useful for computing days between 
dates, dates in the future or past, etc. For example, to determine the number of days between a 
date field and January 1st 1999, use this expression:
date - CTOD('01/01/99')

To compute the date 30 days in the future, use this expression:
DATE() + 30

Examples

12 + 22

(12 * 24) + 6

SIN(x)

qty*price



subtotal * (1+(tax/100))

city = 'CHICAGO' -> Returns .T. (the 'true' constant) when the 'city' field starts with 'CHICAGO'.

'CHICAGO' $ UPPER(city) -> Returns .T. when the 'city' field contains 'CHICAGO' in any case.
    
state = 'TX' .AND. city = 'HOUSTON' -> Returns .T. when the 'state' field starts with 'TX' and the 
'city' field starts with 'HOUSTON'.

qty1+qty2 > 100 -> Returns .T. when the 'qty1' field added to the 'qty2' field is greater than 100.

SUBSTR(zip,5,1)='3' -> Returns .T. when the fifth digit of the 'zip' field contains a '3'.

CTOD("02/05/99")+5 returns the date value "02/10/99".



FLOOR(num)
Description Rounds a number down to the nearest integer.

Syntax FLOOR(number)

number is the value to round.

Remarks Returns the nearest integer value (whole number) less than number.

See Also CEIL function

Examples FLOOR(1.23459, .05) returns 1.2

FLOOR(-148.24, -2) returns -149



Field command (Draw menu)

Field Drawing tool. Activate by clicking on the Field Toolbar button, or by selecting the Draw-
Field command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a rectangle 
to the desired size of the field.
3) Release the mouse button when done.

Height of the field is fixed to a multiple of the selected font height. When changing a font, be 
sure to also readjust the height of the field.

When the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's 
corner points will "snap" to the nearest grid points.

You may begin creating data entry fields at any time during Master Form design.

Fillout Field Order

When a form is filled out, the Enter and Tab keys will move to the next or previous field based 
on a normal left to right, top to bottom ordering.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Field Setup - Calculation dialog tab

These settings control the field calculations available during fillout-mode. A calculation speeds 
fillout by automating mathematical computations.

During fillout the user is made aware of an available calculation by the enabled Field Calculate 
command and toolbar button.

A calculation consists of an expression that must evaluate to a result type that matches its field. 
The Fields, Operators and Functions lists are there to assist your building of expressions. You'll 
notice that the Validation tab is organized in much the same way. You can use the lists for 
reference and type the actual values into the expression by hand, or you can double-click on an 
item to have it paste into the expression at the current cursor location.

Fields:
A listing by name of all the fields currently established in the form. You can change the name of 
the current field from the Options tab.

Operators:
A listing of available math and logical operators.

Functions:
A listing of functions to enhance form entry. Typical functions will require additional parameters.

Expression:
Enter a mathematical formula using field names, operators, constants and functions. The result 
of the expression must match the field type. For Example, field total is of numeric type. In an 
expression such as 'price1 + price2' both the price1 and price2 fields must also be of numeric 
type. Otherwise an error will result.

Test button:
Click on this button to verify the expression. Any changes to the expression can be immediately 
tested.

Field name:
This is an unmodifiable field that simply serves as a reminder of what field these options are for. 
The field name can only be changed in the Options tab.



Field Setup - Help dialog tab

These settings control the field help available during fillout-mode. Field help provides the form 
filler with explanatory text written by the form designer. Typically, only those fields that require 
extra guidance or explanation will need field help.

During fillout the user is made aware of the availability of field help by the enabled Field Help 
command and toolbar button.

Field Help:
Enter any descriptive text here. Usually it is most useful to explain what the field contents should
be. Text will wrap when needed, and you can use Ctrl+Enter to force a line break.

Test button:
Click on this button to see how the field help will look during fillout. Any changes to the help text 
will be reflected in this test window.

Field Help File:
A Field Help File can be used instead of the above Field Help box. Using a file allows for easier 
sharing of field help among many fields and even among many different forms. To create the 
Field Help File, use any straight-ASCII editor like Windows Notepad. To create a file from the 
above Field Help box contents, use the standard Windows copy and paste capabilities.

Browse button:
Click on this button to find an existing field help file.

Auto Popup:
Toggled on the Field Help will popup immediately after the cursor has entered the field. The 
setting indicated in the Preferences-Fillout Tab will override this setting

Field name:
This is an unmodifiable field that simply serves as a reminder of what field these options are for. 
The field name can only be changed in the Options tab.



Field Setup - Options dialog tab

These settings control fillout-mode field content and format.

Type
Controls field content.

• Character Alpha characters and non-calculated 
numbers such as Zip-codes.

• Numeric A set of numbers that represents a countable
value

• Date Any date value, formatted to match the 
Windows International Settings

• Logical Accepts only True/False or Yes/No values

Automatic
Controls automatic data entry when the cursor enters the field.

• Number A unique number for each new form

• Date Current date

• Time Current time

• Calculated Formula execution - A new tab appears 
allowing you to establish a formula for this
field

• Remember The field is not cleared when a new form 
is filled out.

• None No automatic data entry set for this field

n Allow Entry Allows direct entry into a field, possibly 
overriding automatic entry.

Field Name
Indicates the name currently assigned to the field. Use a name that reflects the field's content or
purpose. Field names must be unique. The field name identifies a field for use in fillout order, 
calculations and validations. Whenever a new field is created, it is automatically given a default 
name. A field name can contain up to 10 alphabetic, numeric or '_' characters. Alphabetic case 
in the field name is insignificant.

NOTE: The following selections apply to the display format of numeric-type fields only.

Field width
Set the total formatted width of the field, including the decimal point and digits after it.
Examples:
To display a number as 1.05, use a field width of 4.
To display a number as 1000, use a field width of 4.

Digits after decimal pt
Set the number of decimal places used in the field.



Examples:
To display a number as .012345, use a value of 6.
To display a number as 1000, use a value of 0.

Leading Zero Trim
Suppress any zeros that appear on the left side of the number.
Examples:
002345.00 displays as 2345
001.2000 displays as 1.2
001200 displays as 1200

Trailing Zero Trim
Suppress any zeros that appear on the right side of the number.
Examples:
2345.00 displays as 2345
1.2000 displays as 1.2
1200 displays as 1200

Zero Suppress
If there is no value represented in the numeric field there will not be a zero shown. This will 
prevent an invoice form with only one item listed from getting cluttered with a page filled with 
zeros in all of its numeric field columns such as Size, Quantity, Unit Price and Extended Total.

Auto Number File
This applies to numeric-type, automatic-number fields only.

Without a file name here, the default file 'autonum.num' is used. In this case, the auto number 
sequence starts at 1 and continues by adding 1 each time a new form is filled out. This default 
sequence can be changed by specifying an Auto Number File. This file can be shared by 
multiple EZ-Forms users for a company-wide or departmental numbering system such as 
purchase order number or RMA number.

An auto number file consists of a single line:

<next value>, <optional increment>

The <next value> can be any valid whole number, including negative values.
The <optional increment> is optional and can contain any valid whole number including negative
values.

When an auto-number field is encountered in a form during fillout, the <next value> is 
automatically placed into the field, and the next number will replace the number just used. The 
next number is calculated by adding the <optional increment> value to the number just used. 
The next number to use will always be in the auto-number file.

Allow Entry
Allows the user to change the data in a field that would normally have auto-entry or a calculated 
value.

Browse button



Click on this button to find an existing auto-number file.



Field Setup - Pick List dialog tab

These settings control the field pick list available during fillout-mode. A pick list provides the form
filler with a pre-defined set of choices for field content. This makes filling out a form quicker, 
easier, more accurate and more consistent.

During fillout the user is made aware of the availability of a pick list by the enabled Field Pick 
command and toolbar button.

Pick List:
Each line here represents an individual pick list item. Use Ctrl+Enter to move to a new line. 
Each item consists of:

<value>;<description>

<value> must match the field type (character, numeric, etc.).
; (semicolon) is the separator, which is required if <description> is present.
<description> can be any string of characters.

On selection of an item during fillout, the <value> replaces the current field contents, if any.

Test button:
Click on this button to see how the pick list will look during fillout. Any changes to the pick list 
items will be reflected in this test window.

Pick List File:
A Pick List File can be used instead of the above Pick List box. Using a file allows for easier 
sharing of a pick list among many fields and even among many different forms. To create the 
Pick List File, use any straight-ASCII editor like Windows Notepad, and arrange the pick list 
items as described above, 1 item per line. To create a file from the above Pick List box contents,
use the standard Windows copy and paste capabilities.

Browse button:
Click on this button to find an existing pick list file.

Auto Popup:
Toggled on the Field Pick List will popup immediately after the cursor has entered the field. The 
setting indicated in the Preferences-Fillout Tab will override this setting. When setting an Auto 
Picklist for a field, the list is displayed over the form and may hide the field's label or question. 
You may want to enter at the top of the list the label or the question that the use will be 
answering.

Sort List:
When this selection is on, the pick list will display in ascending, alpha-numeric order. Otherwise 
the list displays in the original order.

Field name:



This is an unmodifiable field that simply serves as a reminder of what field these options are for. 
The field name can only be changed in the Options tab.



Recalc All (Field menu)

Recalculate and revalidate all fields. This command is not always required, since validations 
and calculations are carried out as the cursor moves from field to field. They are again carried 
out whenever a form is committed to use, such as when it is saved or printed.

See Also

Process Dialog



Field Setup (Form Menu)

Modify attributes for the selected field by using the Field Setup command in the Form menu or 
the object popup menu. The attributes include a wide variety of features designed to make fillout
easier, quicker and more accurate.

See Also

Field Options dialog box
Field Pick List dialog Tab
Field Help dialog Tab
Field Validation dialog Tab
Field Calculation dialog Tab



Field Setup - Validation dialog tab

These settings control the field validation available during fillout-mode. Validation assures that 
the form filler places appropriate data in the field. When an invalid entry is made, a configurable 
error message displays. As a form designer, you can use field help to further explain the field 
contents and a field pick list to offer a set of choices.

During fillout the user is made aware of the availability of a field validation by the enabled Field 
Validate command and toolbar button.

A validation consists of an expression that must evaluate to a true result during fillout. The 
Fields, Operators and Functions lists are there to assist your building of expressions. You'll 
notice that the Calculation tab is organized in much the same way. You can use the lists for 
reference and type the actual values into the expression by hand, or you can double-click on an 
item to have it paste into the expression at the current cursor location.

Fields:
A listing by name of all the fields currently established in the form. You can change the name of 
the current field from the Options tab.

Operators:
A listing of available math and logical operators.

Functions:
A listing of functions to enhance form entry. Typical functions will require additional parameters.

Expression:
Enter a mathematical formula using field names, operators, constants and functions. The result 
of the expression must be True or False. For Example (for field001):

field001<100 Will present the form filler with an error message when the value of field 'field001'
is greater than or equal to 100. In other words, the contents of field 'field001' must always 
contain a value less than 100.

Test button:
Click on this button to verify the expression. Any changes to the expression can be immediately 
tested.

Error Message:
Specify an error message to display during fillout when the field contents does not pass the 
validation specified by the above expression. When this is left empty, a default error message 
will display.

Allow Override on Error:
Cursor is not allowed into a calculated field with the Override toggle set in the Form-Field Setup-
Options tab dialog box. Selecting only the Allow Override in the Validation tab dialog will have 
no effect on the cursor.



Field name:
This is an unmodifiable field that simply serves as a reminder of what field these options are for. 
The field name can only be changed in the Options tab.



Open / Fillout / Browse Dialog

Select a file to open by using the File-Open command for master or fillout forms. Master forms 
containing fields can be opened for fillout by using the File-Fillout command. At various other 
points in EZ-Forms, a Browse button is available to help locate a file of interest. The dialog 
window title will indicate which command was selected.

This dialog is the File Open common dialog used in most Windows programs.

File Name:
This area of the dialog box shows a listing of files available in the current subdirectory. If a tab is
in the scroll bar at the right edge of this area, use it to scroll through the file listing. Use 'List File 
of Type' to quickly choose what file types to show. Enter wildcard file names to control what files 
are shown.

Directories:
This section indicates the current subdirectory. Use the section below to change to a different 
subdirectory. Change subdirectories by using the scroll bar or double-clicking on a directory 
name. If a directory is not shown it may be located as a subdirectory below the one just above 
the current subdirectory. Try double-clicking on a directory name that is one or two levels above 
the current subdirectory.

List Files of Type:
Click on the arrow to change the type of files listed in the section just above.
Available choices are:
      Master Forms. (*.frm)
      Filled-Out Forms (*.fof)
      Fillout Masters (*.fom)
      All Forms (*.frm, *.fof, *.fom)
      Graphics (*.bmp, *.dib)
      All Files (*.*)

During Browse the file types may differ.

Drives:
Click on the arrow to display other available drives.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version does not support network drive or services access even though 
the Network button may be active.



Fillout Command (Edit menu)

Design Mode

When the active form has field objects available for data entry, this menu selection will allow you
to begin entering data into the form. You will first be asked to provide a unique name for the 
FOF (Filled-Out-Form) file you are about to be filling out. When saving a form with filled-out 
fields, the file name will have a .FOF extension.

Use the File-Fillout command instead when the master form has not yet been opened.

When a filled-out form is saved or printed, it is actually committed to use. This means that a 
form printout or a file will be presented to someone for actual use as a form. For example, an 
expense form is committed to use when it is presented to a manager for approval. An invoice 
form is committed to use when it is presented to a customer. This processing can be overridden 
via the Process Dialog that appears when saving or printing a form.



Fillout command (File menu)

Use the Fillout command to open a new window and load an existing Master Form that contains
field objects. This will cause creation of a corresponding Fillout Form file which you will be 
asked to name. The field objects in the Master Form now become data entry fields that can be 
filled out. You can open multiple forms simultaneously. Use the Window menu to choose the 
active form. See Window 1, 2, ... command.

Select the name of the form you want to open in the Fillout dialog box.

You can create new forms with the New command.

When a filled-out form is saved or printed, it is actually committed to use. This means that a 
form printout or a file will be presented to someone for actual use as a form. For example, an 
expense form is committed to use when it is presented to a manager for approval. An invoice 
form is committed to use when it is presented to a customer. This processing can be overriden 
via the Process Dialog that appears when saving or printing a form.

Shortcut
Keys: Ctrl + F



Fillout Mode Overview
Click on an area of the dialog box for further explanation.



Fillout Next (Edit menu)

Fillout Mode

This command is useful when filling out a series of forms, all based on the same master form 
template. Fillout Next prepares for filling out the next form by clearing all fields and prompting for
a new filename. When enabled by the master form author, automated processing is done as 
well, such as auto number, date and time

If the current form is not saved, you are prompted to do so.

When a filled-out form is saved or printed, it is actually committed to use. This means that a 
form printout or a file will be presented to someone for actual use as a form. For example, an 
expense form is committed to use when it is presented to a manager for approval. An invoice 
form is committed to use when it is presented to a customer. This processing can be overriden 
via the Process Dialog that appears when saving or printing a form.



Fillout Order command (Form menu)

Fillout order affects fillout mode only. It controls where the cursor will go after data entry for the 
current field is complete.

Normally, when the Enter key or Tab key (if enabled) is pressed, the next field is defined by 
normal left to right, top to bottom order. The Fillout Order command allows for alternate ordering
to make data entry easier and more intuitive.

See Also

Fillout Order Dialog box



Fillout Order Dialog

Choose fillout order for all fields on the current form. By default, fillout proceeds in left to right, 
top to bottom order. To change this order, simply reorder the field names in this dialog.

Every field has a field name, whether assigned by default or set directly with Form Field Setup 
Options. The list in this dialog contains all field names. The order of these names reflects the 
order used during fillout. The Up and Down buttons will move only the currently highlighted field 
or fields by a single position. Use these buttons repeatedly to move a field anywhere within this 
list.

Move several fields names at once:
Select one field name. Press and hold the Ctrl key. Select several field names that are 
separated. Release the Ctrl key and use the Up / Down buttons to move the highlighted field 
names.

Select one field name. Use the scroll bar to locate the end of a group of fields names. Press and
hold the Shift key. Select the second field name and all field names between the first selection 
and the second selection will be highlighted. Release the Shift key and use the Up / Down 
buttons to move the highlighted field names.

At any time, the default left to right, top to bottom field order can be reinstated by clicking on the 
Normal button.



Font command (Form menu)

Modify font attributes for the selected Text or Field object by using the Font command in the 
Form menu or the object popup menu.

See Also

Font dialog box
Text dialog box



Font command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Font dialog box are used to set defaults for all 
newly created text and field objects. Existing objects are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Font Dialog

Choose font name, style etc. for Text and Field objects. When accessed with the Options-
Defaults-Font menu, font selections will only affect newly created objects.

The font characteristics of any Text or Field object can be altered after placement by using the 
Form-Font command, accessible from the main menu or the object popup menu. If an object's 
font height is changed, readjust the object height by repositioning its bottom line.

Font:
Type in the name of the font, or use the section below to select from available fonts.
Shows fonts that are available on your system.

Font Style:
Type in the font style you want, or select from choices below.
The listed styles are valid for the font selected to the left.

Size:
Type in the font size you want even if the size is not an available choice in the section below. 
Some sizes may not be visible or printable on certain systems. Select the font size you want, or 
enter a different size in the section above. TrueType fonts support any size.

Effects:
Additional character attributes for both Text and Field objects.

Color:
Click on the arrow to view a selection of colors for the chosen font.

Sample
Displays the character set as defined in other sections of this dialog box.



Form Layout command (Form menu)

The Form Form-Layout command will display the Layout dialog box. During form design, the 
form's size, margins, etc. may be modified to accommodate the paper or printer you are using. 
Be aware that some printers do not support all possible margin settings.



Form Layout command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Form Layout dialog box are used to set defaults 
for all newly created forms. Existing forms are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Frequently Asked Questions
What is an Eform?

Importing/Scanning Images into EZ-Forms

Using EZ-Forms with Microsoft Word, Microsoft Excel, and any other OLE enabled program. 
(and visa-versa)

Duplicating information in subsequent fields.

EZX's Special Purpose Eforms Automation Products Include:

What are some of your internet web page URL's?



Functions
ABS(num) Returns the absolute value of a number.
ACOS(num) Returns the arc cosine of a number.
ASIN(num) Returns the arcsine of a number.
ATAN(num) Returns the arctangent of a number. 
ATAN2(num,num) Returns the arctangent of <num 2> / <num 1>.

CEIL(num) Rounds a number up to the nearest integer.
COS(num) Returns the cosine of an angle.
COSH(num) Returns the hyperbolic cosine of the specified angle.
CTOD(char) Converts Character to Date type.

DATE() Returns today's date.
DTOC(date) Convert Date to Character type.
DTOS(date) Converts Date to String.

E() Returns the e mathematical constant.
EXP(num) Returns e raised to the specified power.

FLOOR(num) Rounds a number down to the nearest integer.

HYPOT(num,num) hypotenuse - square root of (x squared + y squared)

IIF(log,any,any) Tests the condition and returns either value.
INSTR(char,char) Returns position of char 1 in char 2

LDEXP(num,num) Returns the value of <num1> * (2 raised to the power of <num2>).
LOG10(num) Returns the base-10 logarithm of a number.
LOGN(num) Returns the natural logarithm of a number.
LOWER(char) Changes the characters in the specified string to lowercase.
LTRIM(char) Returns the specified text string with blanks trimmed from the left 

side.

MAX(num,num) Returns the largest value of both numbers.
MAXEXP() Maximum exponent value.
MAXVAL() Maximum representable numeric value.
MIN(num,num) Returns the smallest value of both numbers.
MINEXP() Minimum exponent value.
MINVAL() Minimum representable numeric value.
MOD(num,num) Returns the remainder after dividing <num1> by <num2>.

PI() Returns the value of the pi mathematical constant.
POW(num,num) Returns <num1> raised to the power of <num2>.
PROPER(char) Returns the specified string in proper-case format.

RTRIM(char) Returns the specified text string with blanks trimmed from the right
side.

SIN(num) Returns the sine of the specified angle.



SINH(num) Returns the hyperbolic sine of the specified angle.
SQRT(num) Returns the square root of the specified number.
STOD(char) Converts string to format-independant date.
STR(num,num,num) Converts a Numeric value to a Character value
SUBSTR(char,num,num) Returns a portion of the original string

TAN(num) Returns the tangent of the specified angle.
TANH(num) Returns the hyperbolic tangent of the specified angle.
TIME() Returns the current time.

UPPER(char) Converts Character String to upper case.

VAL(char) Returns the specified text as a number.



Getting Started
This documentation assumes a working knowledge of Windows and its user interface. Our on-
going goal is to always provide user interface ease, simplicity and consistency within EZ-Forms,
as well as consistency with other Windows applications. This will serve to help you get started 
as quickly and easily as possible.

To get started, first learn the terminology, then read about what commands to begin with, then 
read about how EZ-Forms' on-line help is organized.

Terminology

Form
Master Form
Design Mode
Fillout Form
Fillout Mode
Object
Drawing Tool
OLE Object
Expressions

What to do

In EZ-Forms, you may be currently working in the Main Window without any active forms. Here 
are at least three ways to get started, listed here in order of complexity.

Note:    Some distribution sets do not contain the files mentioned. Please substitute for 
appropriate file types.

1) Load an existing master form in order to fill it out. Try expense.frm. You may need to change 
to a subdirectory named FIELDS. Use the File Fillout command, type

expense.frm
a dialog box appears asking for the name you want to give the new filled-out form. Type 
expense.fof then select OK. F1 will display fillout help. Now fill out some fields. When ready, 
save it with the File Save command.
2) Load an existing fillout form in order to fill it out or modify it. Try expense.fof. Use the File 
Open command, type

expense.fof
a dialog box appears asking for the name you want to give the new filled out form. Type either 
the same name to modify the existing form or any unique file name to create a different form, 
then select OK. F1 will display fillout help. Now fill out some fields. When ready, save it with the 
File Save command. Or use File Save As to save it with a different file name, leaving the original
file unchanged.
3) Create a new form with File New and design a new master form. Press F1 for design help. 
Select a drawing tool and place an object using the mouse. Place text, fields and graphics in the
same manner. When ready, save it with the File Save command and specify a unique name.

On-line Help



In general, on-line help is available at any time by pressing F1. The help that appears will be 
context sensitive, meaning that it will apply to the current place in EZ-Forms. Overall, there are 
three ways to access help. They are:

F1 Select a command, then press F1 to get context sensitive help.
Shift + F1 Press Shift + F1, then choose a screen element, toolbar button or menu item on 
which to get help.
Help menu Select a general topic.



Go To Page    (View menu)
Multi-page forms allow two or more associated pages to be stored in one form file. There are 
three types of commonly used pre-printed multi-page form designs. One type is where the front 
and back of a single sheet of paper requires data entry. Then, of course, there's the stack of 
pages all relating to a particular subject sometimes referred to as - “a form”. Another type may 
have several layers where the data entered on the top layer is transferred to a duplicate sheet 
or to different sections in each of the underlying sheets.

 EZ-Forms can store in a single form file, the front and back of a two sided sheet of pre-printed 
paper, a group of several related pages, or allow data entry into the first page have have that 
data duplicated automatically to all fields in the remaining pages.

There are a couple of methods to assist in your navigation through multiple pages in a single 
form display.

1 -    In the View pulldown menu select Go To Page for the follow options.
First
Previous
Next
Last

2 - Click over an arrowed icon on the Toolbar to move to the Next Page or the Previous Page.



First
With a multi-page form loaded, and the current page number of the form is greater than one, 
selecting the Got To Page - First option from the View pulldown menu will change the display 
and focus to the beginning of the sequence of the active form.

See Also

Got To Page
Previous
Next
Last



Last
With a multi-page form loaded, and the current page number of the form is not the last page of 
the form, selecting the Got To Page - Next option from the View pulldown menu will change the 
display and focus to the final page in the sequence of the active form.

See Also

Got To Page
First
Previous
Next



Next
With a multi-page form loaded, and the current page number of the form is not the last page of 
the form, selecting the Got To Page - Next option from the View pulldown menu will change the 
display and focus to the next page in the sequence of the active form.

See Also

Got To Page
First
Previous
Last

Shortcut
Toolbar:



Previous
With a multi-page form loaded, and the current page number of the form is greater than one, 
selecting the Got To Page - Previous option from the View pulldown menu will change the 
display and focus to the preceding page in the sequence of the active form.

See Also

Got To Page
First
Next
Last

Shortcut
Toolbar:



Grid command (Form menu)

Use the Grid dialog box to change grid attributes. You can modify grid spacing as often as 
needed using the Form-Grid pulldown menu command. These grid settings only affect and are 
saved with the current form.

Note:    If a different grid setting or multiple grid settings are used during design mode, the last 
grid used will be saved as part of the that particular form regardless of the settings defined in 
the Options-Defaults Grid dialog box.
Example:    Most of the forms you design use the same grid setting. Some of the forms use a 
unique grid setting. Set the Options-Defaults-Grid settings to those most frequently used. For 
those forms that do not use the pre-defined grid options, select Form-Grid to temporarily change
the settings. Saving the form will maintain the grid that was last set during design mode.

You may wish to adjust grid settings for different sections of the form. The snap-to-grid feature 
helps keep objects lined up and assures a professional appearance to your form. There will be 
times when you will want to turn off the snap-to-grid feature in order to hand-place objects that 
do not correspond to any grid. During form design, the F2 key toggles snap-to-grid on and off.

Micro Move Objects
Any time during design mode, the selected object can be “micro-moved” by using cursor keys to
move the object in very small increments. When snap-to-grid is turned on, press Shift and the 
corresponding cursor key to move the selected object from grid point to grid point.



Grid command (Options-Defaults menu)

Use the Grid dialog box to set grid attributes. Save the settings as default for newly created 
forms by using the Options-Save Settings command. You can modify grid spacing for current 
forms as often as needed using the Form-Grid pulldown menu command. All options are saved 
into the .INI file with the Options-Save Settings command.

You may wish to adjust grid settings for different sections of the form. The snap-to-grid feature 
helps keep objects lined up and assures a professional appearance to your form. There will be 
times when you will want to turn off the snap-to-grid feature in order to hand-place objects that 
do not correspond to any grid. During form design, the F2 key toggles snap-to-grid on and off.

Micro Move Objects
Any time during design mode, the selected object can be “micro-moved” by using cursor keys to
move the object in very small increments. When snap-to-grid is turned on, press Shift and the 
corresponding cursor key to move the selected object from grid point to grid point.



Grid Dialog

Use the form design grid settings to help you place objects precisely, and to help align objects 
vertically and horizontally. The grid will not be visible in fillout mode. When accessed with the 
Options-Defaults-Grid menu, grid selections will only affect newly created forms.

The grid characteristics of an object can be altered for an existing form by using the Form Grid 
command, accessible from the main menu or the object popup menu. The dialog box title will 
not include "Defaults" when modifying an existing form.

Spacing
Horizontal:
Horizontal spacing determines the spacing between vertical lines of the grid.

Vertical:
Vertical spacing determines the spacing between horizontal lines of the grid.

Selections
Grid Visible:
For design mode, toggle the on-screen visible grid ON / OFF. In Fillout Mode the grid is always 
off.

Snap to Grid:
When placing, moving or resizing objects, end points are automatically forced to conform to the 
nearest grid coordinates. For example, each end of a Line object will "snap-to" the nearest grid 
point. All four corners of Text, Field and shaped objects will "snap-to" each of the nearest grid 
points, giving you simpler, easier placement capability. A grid point is any intersection of a 
horizontal and vertical grid line. You may also “micro-move” (arrow keys) and “mini-move” (Shift 
plus arrow keys) objects for even finer control. The F2 key will toggle this snap-to option while 
designing a form.

Grid Color button
Access the Color dialog to choose from a given color set.



HYPOT(num,num)
Description Calculates the hypotenuse of a right triangle.

Syntax HYPOT(x, y)

x and y are the lengths of the two sides that connect to form the right angle.

Remarks Returns the length of the hypotenuse, which is the remaining side. Computes 
the square root of (x squared + y squared).

Examples HYPOT(1, 1) returns 1.414.

HYPOT(3, 4) returns 5



Help command (Field menu)

When field help exists for this field, this command will display that help. Field help is written by 
the form designer and typically serves to explain the field contents in non-obvious cases.

Field help is presented in a simple dialog box. Either press the Enter key, or click on the OK 
button to continue filling out the form.

Shortcut
Toolbar:
 Keys: Ctrl + H



Context Help command

Use the Context-Help command to obtain help on a specific EZ-Forms function. When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark. Click somewhere in the EZ-Forms window, such as another Toolbar button, or 
pulldown menu. The Help topic will be shown for the item you click on, if it applies.

Shortcut
Toolbar:
Keys: Shift + F1



How To . . .
Access Forms Over the Internet

Organize Files

Work With Multiple Forms

Micro-move and Mini-move Objects

Utilize a Sound Card

Use Form Design and Fillout

Modify Object Attributes

Use Command Line Options

Select Multiple Objects

Use The Grid

Move/Resize Objects

Create icons for your forms.



How To Access Forms Over the Internet
Visit Our Web Site at http://www.ez-forms.com/internet for an online demonstration.

Note:    The following is for licensees of EZ-Forms PRO. Visit the Web site for further 
information.

Save the web page from your browser and examine the HTML code structure. Note that the 
embed command is the key to loading a form into a local program. As long and the association 
for the file extensions .FOM and .FOF are set to EZ-Forms or an EZ-FormsFiller series the 
downloading form will load directly into the locally installed program.



How To Create icons for your forms.
See Lesson 19 in the Tutorial Help file for instructions on setting up forms you've designed to be
launched from their own group and individual icons. Instructions relate to Windows 3.1 use, but 
may be conceptually helpful for Windows 95.



How To Micro-move and Mini-move Objects
Often times you will need an object positioned between grids points. You can use EZ-Forms' 
micro-move feature to fine-tune the form. Micro-move works whether or not “snap-to-grid” is 
turned on via the Options-Defaults-Grid or Form-Grid dialog box snap-to-grid selection.

To use this feature, select an object and use the arrow keys to micro-move it to a new position. 
Shift-arrow key (mini-move) will move the object from grid point to grid point if “snap-to-grid” is 
turned on. If “snap-to-grid” is turned off, the movement is actually the same as micro-move.

Do NOT continue to hold the mouse button after you have selected the object as this will cause 
the object to snap back to the defined grid if you have “snap-to-grid” turned on.

After dragging an object halfway across the form to a new location, sometimes the mouse is a 
bit difficult to use for precise placement with “snap-to-grid” toggled OFF. In this case you can 
drop the object very close to the position desired and use micro-move to fine tune the 
placement.

Note:    Even if snap-to-grid is turned on, you may still micro-move a selected object with the 
keyboard arrow keys as long as the object is still selected. This allows for very precise 
positioning of the object.

You may also use mini-move by depressing and holding the Shift key while making 
movements with the cursor keys. If “snap-to-grid” is turned on, the movements here are actually 
from grid point to grid point. If “snap-to-grid” is turned off, then the movement is actually the 
same as micro-move.



How To Modify Object Attributes
An object can have one or more of the following attribute groups:

Text
Font
Pen
Brush
Printable
Field Setup

Each of these attribute groups except for Printable, has an associated dialog box that allows 
modification of the attributes within that group. Printable is a simple on/off toggle.

An object is created by first selecting a drawing tool, then using the mouse to place and size it. 
At creation time, an object's attributes are defined by settings in the Options-Defaults menu. 
These defaults are saved in the (program).INI file in your Windows directory. For example, the 
Options-Defaults-Text command accesses the Text dialog box for the text default attributes. 
Field Setup is unique in this regard because it's default setting are fixed. This is due to the 
complex nature of a field object's attributes which involve formatting, calculations, etc.

Once an object exists, its attributes can be modified at any time in design mode by altering 
settings that are accessible via the Form menu or the object popup menu. These settings are 
saved with the object in the Master Form (.FRM) file. For example, when a rectangle object is 
selected, the Form-Pen command accesses the Pen dialog box for the Pen attributes of the 
selected rectangle.

See Also

Moving and Resizing Objects



How To Move/Resize Objects
Once an object is placed in design mode, it can later be moved, resized, deleted or copied. 
Delete and copy are available through the Edit Cut/Copy/Paste menu commands. Moving and 
resizing are accomplished through mouse click and drag operations. Arrow keys can also be 
used to move an object.

Selecting Objects
Similar to other operations on an object, select it before moving or resizing. Choose the Select 
drawing tool via the toolbar button, or the Edit Select or Draw Select menu commands. 
Selection is done by a single left button mouse click anywhere on or inside the object. A 
selected object is indicated by the appearance of handles on all its end points, corner points or 
edges.

Moving
After selection, move an object by a drag and drop mouse operation. To drag, hold the left 
mouse down anywhere on a selected object and move it while continuing to hold the left mouse 
button down. To drop, simply release the mouse button.

The up, down, left and right arrow keys will also move an object. The object is moved in the 
smallest possible increment in the direction of the arrow key. When the grid is on and the Shift 
key is also pressed, the object moves to the next grid point following the direction of the arrow.

Resizing
After selection, resize an object by first moving the mouse cursor over one of the selection 
handles. You will notice the mouse cursor changes to either a left-right arrow, up-down arrow, or
a diagonal arrow. While the cursor is one of these shapes, object resizing is done by a drag and 
drop mouse operation. Note that resizing is disabled when multiple objects are selected.

A left-right or up-down arrow usually appears at the edge of an object. This represents the 
possibility of resizing by moving only the edge represented by the handle the cursor is on.

A diagonal arrow usually appears at an end point or corner point of an object. This represents 
the possibility of resizing by moving this point. For corner points, both edges are resized to 
match the mouse movement.



How To Organize Files
For your own convenience, you may want to keep certain files separated into different 
subdirectories.

Examples might be:

Use a Pre-Printed Forms subdirectory named      C:\Program\PPF\      for storing all forms that 
have data entry fields, but print only the data and not the background form design. This type of 
master form is used for pre-printed forms purchased from an office supply store, or from a forms
catalog. This type of functionality is also known as CFO (clear forms overlay.)

It is sometimes convenient to place all master forms in one directory, and all fillout forms in 
another.

Other subdirectories may be assigned for departments, specific employees, job/task related 
forms, etc.



How To Select Multiple Objects
Single Objects:

Cut, Copy, Paste a Single Object:
Open an existing form and click the mouse cursor on one of the objects in the form to select it. 
Press the Ctrl + C key combination to copy the object to the clipboard. From the File pulldown 
menu select New, then click the OK button. Press the key combination Ctrl + V to paste the 
object from the clipboard to the new form. Now you have two forms with a duplicate copy of the 
object. Using the key combination Ctrl + X while in the original form would have deleted the 
object from the form and placed it into the clipboard, making it available for a Paste operation in 
another form.

Use the pulldown menu command Edit-Cut ( Ctrl + X ) to move an object from the form to the 
clipboard.
Use the pulldown menu command Edit-Copy ( Ctrl + C ) to move a duplicate of the object to the 
clipboard.
After using the Cut or Copy features, create or move to a different form.
Use the pulldown menu command Edit-Paste ( Ctrl + V ) to place one or more duplicates of 
what is stored in the clipboard.

Multiple Objects:
Normally, mouse clicking on an object will select it and deselect the previously selected object if 
there was one. Holding down the Shift key during object selection will prevent deselection of 
other objects. This allows the selection of more than one object at a time. This group of objects 
can be moved, cut, copied, or pasted, very much like what can be done with singularly selected 
objects.



How To Use Command Line Options
EZ-Forms has a number of command line options. These options are not case sensitive. 
Multiple swithes are allowed, unless they do not make sense.
Note: All of the following function, including Data import/export, are also availble via the File 
Menu pull-down.

/Mmaster.frm    or    /Omaster.frm
Open the Master form indicated by master.frm. This form is automatically loaded into design 
mode after EZ-Forms startup.

/Ffillform.frm
Open the Master or Fillout form indicated by fillform.frm. Be sure the form you use with this 
parameter has fields for data entry. This form is automatically loaded into fillout mode after EZ-
Forms startup. Before fillout can begin, a new name must be chosen for the form. This allows 
for either a Master or Fillout form to act as a fillout template. A similar command in the program 
is File-Fillout.

The following additional parameters can be combined with either of the above to perform Print, 
Import, Export and Exit functions. Frequently used options may be assigned to an icon.    You 
may wish to "iconize" a form that is frequently used throughout the office, Export field data for 
use in a database (or wordprocessor, spreadsheet), or import data that has been generated by 
another program into a new form.

/P
Print the form that is indicated with the /M or /F parameter. This will print with the current printer 
settings and launch the printer diaglog box.

/X      This feature is available in EZ-Forms PRO, ExportPower PRO, WinDD250 PRO, EZ-MSDS and 
FormTrooper.
It is not an available feature in EZ-Forms XL

Export data from the form indicated with the /F parameter.
The data in a completed from is extracted and stored in an ASCII file (.dta extension) with the 
first field's information surrounded by double-quotes on the first line which terminates with a 
carriage return and line feed. The second field's quotation delimited information is placed on the 
second line, etc. Data is export in field order, as set during form creation. A different ASCII text 
file will be generated from each Filled Out Form (.fof).

/I        ( capital i )      This feature is available in EZ-Forms PRO, ExportPower PRO, WinDD250 PRO, EZ-
MSDS and FormTrooper.
It is not an available feature in EZ-Forms XL

Import (or place) data into the form indicated with the /M or /F parameter.
Information stored in other programs can be imported into an EZ-Forms form for better 
appearance and a meaningful structure. When exporting information stored in another program, 
select the ASCII text format that will extract as one data cell or field per text line, with double 
quotations around it. Store one spreadsheet row or one database record in the text file that will 
be used for import into the form. The data should be in the field order as set during form 
creation.



/S
Save the form, and giving it a new filename.

/Z
Terminates the program after completion of the Print, Export or Import operation.

Examples and syntax of command line usage:

The data files EZ-Forms uses must be in ASCII, quotation delimited format. This is a format that 
can be created or read by almost any spreadsheet or database program. One data file is 
imported to or written from each form. Again, most DataBase programs have no problem with 
this.

FYI, a .DTA files' contents may look like this:

"Field001 Data"
"Field002 Data"
"Field003 Data"
"Field004 Data"
"Field005 Data"
"Field006 Data"
"Field007 Data"
"Field008 Data"
"Field009 Data"
"Field010 Data"

This is one record with with 10 data fields.

Example 1:
You need a printout of a form that has no fields that will be filled out manually.

The command line is:
(program).EXE /Mformname.frm /P /Z

The program's splash screen appears to indicate the action is in progress. The print job is 
spooled to the printer with the current printer defaults. After a few moments the splash screen is 
removed indicating that spooling is complete, then the program is shut down. This process does
not open the program into a window and load the form. The form you want to print is sent 
directly through the print function of the program then it is handled by the Windows printer 
driver.

Example 2:
You've designed a form with fields that match the information you need in your spreadsheet 
program. Now you want data that is entered into the forms to be manipulated by your 
spreadsheet (for enhanced calculations, graphs, reports).

The command line is:
(program).EXE /Mformname.fof /Xformname.dta /Z



After filling out a few forms with data, and saving each completed form to a unique name, you 
need to export the data to an ASCII file. Save each export with a .DTA file extension with the 
same filename as the corresponding .FOF file. You will need to generate a unique .DTA file from
each of the forms from which you wish to extract data. Import the text of each .DTA file with your
spreadsheet program as a separate row or record. Check your spreadsheet program's 
documentation for the import procedure for an ASCII file having one double quotation delimited 
data field per line. The .DTA file may represent one spreadsheet row and each line may 
represent spreadsheet cell. This same .DTA file can be imported into databases as a record or 
merged with a wordprocessor document. Check the appropriate docutmentation for the 
procedure.

Example 3:
You already have all of the information you need in a database file. You want a hard copy for 
distribution of each record that will present that information in a specific manner.

The command line is:
(program).EXE /Fformname.frm /Iformname.dta /S /P /Z
or
(program).EXE /Fformname.fom /Iformname.dta /S /P /Z
(Either method asks for a new filename, using the original formname.fof as a template, that will 
contain the data. Imports data from formname.dta saving it to the newname.fof file you indicated
earlier.)

Find the record in your database containig the data you need in the form and export the 
information to an ASCII file. Check your database program's documentation for the export 
procedure to generate an ASCII file having one double quotation delimited data field per line. 
Either a master form(.FRM) or a blank fillout form(.FOF) can be used. The data file will be 
combined with the form placing the information in the first line of text into the first field of the 
form. The second line of the text file will be placed into the second field of the form and so forth. 
The program's splash screen will indicate the action is in progress. The new form, complete with
data, will be sent to the printer and the process will shut down returning you to the desktop or 
program manager.

If you are merging data and sending it directly to the printer all data fields in the form will need to
be accounted for in the text file. No calculations will be performed with this operation. It is 
assumed that any data management will be performed in the originating program whether it is a 
database or spreadsheet.

If you want the command line to load a form into EZ-Forms, merge the data and remain 
displayed on screen just leave off the /P and /Z parameter switches in the command line 
examples.



How To Use Form Design and Fillout
Form Design

The goal here is to create a Master Form by using EZ-Forms' drawing tools to place objects at 
appropriate places on the form. Once an object is placed, it can be moved, resized or have its 
characteristics modified.

Object characteristics can be selected in two ways. One way is by setting default characteristics
via the Options-Defaults menu. These defaults specify the characteristics of newly created 
objects. The other method of setting object characteristics is by selecting an existing object, 
then modifying its characteristics with the Form menu.

When a master form is complete, save it. Once saved it can be reused repeatedly as a template
for form fillout.

Form Fillout
The goal here is to place data into each field in order to fill out the entire form. When done filling 
out a form, save it to a unique name. When ready to fill out a new form, you can use the Edit 
Fillout Next, Edit Clear All or File Fillout commands to do so.



How To Use The Grid
You are not limited to one grid setting during the design of a form. Adjustment of horizontal and 
vertical grid settings can be made at any time to within two decimal places, for example, 0.25, 
0.37, 0.50, etc. If the grid setting is changed, all previously set objects will not “snap-to” the new 
grid unless selected and moved with the new grid settings in place and “snap-to-grid” turned on.
The "snap-to-grid" feature is defaulted to ON at program installation.

“Snap-To-Grid” means that while you are moving or sizing an object (e.g..      creating a line) the 
end points will “snap-to” the nearest grid point intersections around the object. If the entire 
object is selected, it will “snap-to” the nearest grid coordinates. Or if just one of the “handles” on 
a corner or side is selected, only it will snap-to-grid when released. The “snap-to-grid” feature 
can be turned on or off at will via the Form-Grid dialog box. The F2 key also toggles the “snap-
to-grid” feature.

Note:    Even if snap-to-grid is turned on, you may still micro-move a selected object with the 
keyboard arrow keys as long as the object is still selected. This allows for very precise 
positioning of the object.

You may also use mini-move by depressing and holding the Shift key while making 
movements with the cursor keys. If “snap-to-grid” is turned on, the movements here are actually 
from grid point to grid point. If “snap-to-grid” is turned off, then the movement is the same as 
micro-move.

Varying text sizes, lines, boxes, other shapes and imported graphics may need different grid 
settings to place them precisely where you want them.



How To Utilize a Sound Card
An icon representing a prerecorded sound file can be placed on a form. Sound files stored in the
.WAV format can be played during data entry for instructions, or to further “illustrate” a topic. 
(e.g..      telephone ringing, or other sounds)    Use the Edit-Insert New Object command to place 
an icon on your form that will play back the sound file. Choose "Create from File", enter the 
sound file name, then OK.

Check the recording section of your sound card manual for instructions on how to create your 
own sound files and use them in forms you design. The user of your form will be able to click on 
an icon to listen to the file associated with the icon. Embedding the sound file with an automatic 
link will keep the sound file separate from the form.

Sound files will only be played if your system has the proper Windows sound drivers and 
hardware installed. Consult your sound card supplier for more details.

See Also

Inserting OLE Objects



How To Work With Multiple Forms
It may be helpful at times to have several forms open at once for comparison, work in progress, 
or to copy / move text, fields, or objects from one form to another. Too many open forms may 
clutter up your screen desktop. Iconizing (minimizing to icon view) some of the forms using the 
Minimize command contained in the Control tab menu for the form window can clean things up 
considerably.

One example of the convenience of multiple open forms is in the case of cloning (or duplicating)
an existing form (master or fill-out) and modifying it for a slightly different use while preserving 
the original form. To do this, use “File-Save As” to save the form to a new and different name. 
The original form is saved and closed for safety. You may reopen the original with the File-Open 
command or Toolbar icon in order to keep it on-screen for reference. You can even open 
another form that has an image (like a logo or signature) that you would like to copy to your new
form. Highlight the image in the third open form and select the Edit-Copy command. The image 
is stored in the Windows' clipboard and can be pasted into the new form. Click on the new form 
that is to contain the image and select the Edit-Paste command. The object will immediately 
appear in the new form with all attributes identical to the original.

Available system memory and system resources have a lot to do with being able to transfer 
images. If problems occur, select the image and position the mouse cursor on the bottom right 
corner object handle (tab). Press and hold the left mouse button and drag the corner to make 
the image smaller. Repeat the transfer steps then increase the images size after moving it to the
other form. If this is not sufficient to move the image, you may need to shut down some of the 
other applications you currently have running in Windows.



IIF(log,any,any)
Description Tests the condition and returns the specified value.

Syntax IIF(condition, true_value, false_value)

condition is any logical expression.
true_value is the value to be returned if condition evaluates to True.
false_value is the value to be returned if condition evaluates to False.

See Also Operators 

Examples IIF(field001>10, "Over", "") returns "Over" if the contents of field001 is greater
than 10 and "" if the contents of field001 is less than 10.

IIF(RTRIM(field001)="", DATE(), field001) returns today's date whenever 
field001 is all blank. Otherwise it returns the contents of field001.



INSTR(char,char)
Description Returns position of a character string within another.

Syntax INSTR(char1, char2)

char1 is the character string to search in.
char2 is the character substring to search for.

Remarks Returns the starting position of the substring char2, within the string char1. 
When combined with the Substring function, SUBSTR, you can retrieve 
portions of a field, based on its contents.

See Also SUBSTR

Examples INSTR("Cancun", "nc") returns 2.

SUBSTR(NAME,1,INSTR(NAME,' '))    -    returns first name from field NAME.



Import (File menu)      This feature is available in EZ-Forms PRO, ExportPower PRO, WinDD250 PRO, 
EZ-MSDS and FormTrooper.
It is not an available feature in EZ-Forms XL

/I
Import (or place) data into the form indicated with the /M or /F parameter.
Information stored in other programs can be imported into an EZ-Forms form for better 
appearance and a meaningful structure. When exporting information stored in another program 
select the ASCII text format that will extract one data cell or field per text line, with double 
quotations around it. Store one spreadsheet row or one database record in the text file that will 
be used for import into the form. The data should be in the field order as set during form 
creation.

For additional information, other parameters and example usage see Hot To Use Command 
Line Options.



Importing/Scanning Images into EZ-Forms
Scanning Forms (Logos and other Pictures Too) for Fillout or Background Use

Scanning existing forms can be a quick way to automate your forms, but there are a number of 
issues for you to consider:

1. A new(Ctrl + N) or existing(Ctrl + O) form must be open in order to scan an image or import a 
graphic.    You must have a TWAIN compliant scanner. Note that even if your scanner is TWAIN 
compliant, it may may not scan properly due to many possible factors including other software, 
conflicting hardware, etc.

2. An alternate is to scan your image with the software that came with your scanner. Always 
save the file to a .BMP file prior to importing into EZ-Forms. If your scanner is not TWAIN 
compliant or cannot save to a .BMP file, all is not lost as you can scan to almost any format and 
convert the image to a .BMP with one of the may fine graphics conversion programs available 
(like Paint Shop PRO ... see below).

3. Once the form image is imported into EZ-Forms, you have the option of declaring it printable 
or non-printable. Printable means view on screen and print when requested along with any data 
and printable object fields.    You can also elect to print only the data fields at print time, if you 
wish. Non-printable means show image on screen, but never print it; print only the data fields 
and/or other printable objects that you have added. Right-click on the image to request the 
dialog box.

4. When scanning your form, scan at the lowest DPI (dots per inch) resolution that produces 
acceptable results. If the form is monochrome, do not scan in color as this will increase the file 
size of your form dramatically. We've found that scanning monochrome (or "line art") at about 
300 DPI is an acceptable comprise of speed, size and quality. It also keeps the file size at about
1 MegaByte for a 8.5" by 11" form. Images of 2MB or greater may be sluggish on-screen and 
take a very long time to print.

5. Prior to scanning a form, it is critical that you "pre-crop" the edges of the form to conform to 
the edge printing limits of your printer (see your printer's on-line help or manual). Otherwise the 
edges of your form may not print correctly. Most scanner software allows you to do this by "pre-
scanning" after which you may move the scan borders to suit. This is also helpful if you are 
scanning a logo. No need to scan the entire page. Just pre-crop, adjust the scan borders and 
go. A typical logo .BMP is then less than 100 kilobytes. If your printer cannot print to the limits of 
the scanned image you have chosen, consider compressing the image slighly to fit. You can do 
this by grabbing the "handles" (bars) around a selected image and dragging them to the 
appropriate position.

6. When scanning-in or importing a .BMP full-page image into a form, it is important that you set
all margins at 0. Even then, your printer driver may override this setting 
when it comes to edge printing. Make sure that you have the latest printer driver from the 
hardware manufacturer and that you review instructions for same as to hard edge 
limits for printing. Check out the Printer-Setup dialog to see what paramaters you can adjust.

7. During image scan or import you will have the choice of storing the image embedded into the 
form, or as a separate file. If you are going to move the form around a lot, select embedded 



(and get some extra disk capacity). If the form is filled-out a lot, try to store the image separate 
from the form. Keeping the graphic external to the form incurs the disk space overhead of the 
image only once. When you fill out a form referencing an image in a separate file, the 
resultant .FOFs (filled out forms) will be much smaller.

8. After you scan or import an image, you may need to align the form properly on the page. This 
may take a little trial-and-error to get the proper positioning as page-to-printer-to-screen 
calibration may not be exact. Print the scanned image to your printer and set it on your original 
in front of a bright light. Move the graphic image on screen as required, and try again. Be aware 
that scanners may distort large images or re-size them slightly.

9. If you determine that the image needs cropping, permanent resizing, or other enhancements, 
we can recommend a fine program called PaintShop PRO. A test drive edition is available via 
the Internet at http://www.jasc.com.

10. If the above recommendations do not produce the results you intended then you should 
consider designing the form with EZ-Forms' proprietary objects method. Forms designed this 
way will look beautiful and print quickly on almost any type of printer. Since there is no large 
graphic image to re-trace, screen updates are much faster too. If you have the time, designing a
form this way will produce dramatically better looking results than the typical scanning 
technology available today.

11. If the color rendition on an imported bitmap (via InsertGraphic) is poor, this may have to do 
with your computer's video resolution. EZ-Forms makes a best attempt at accomodating images
whose color depth is greater than your screen's (video driver) color depth. To improve color 
rendition on screen for photos, etc., the solution is to use InsertNewObject instead of 
InsertGraphic. InsertGraphic is optimized for full page form images or scans, not full color 
graphics. InsertNewObject can handle much more complex images, even voice, etc. via OLE 
(object linking and embedding). This is because it uses an external program like PSP (Paint 
Shop PRO) or PBRUSH (Microsoft PaintBrush) to "service" the image. 

12. If you don't have the time to "electronify" your forms, or just don't want to mess with it, FAX 
(at +1-281-280-0099) or mail blank and filled-out examples to us. We'll return a quotation to you 
as soon as possible. We can even create forms from a sketch.

13. With a little patience, you can create a fine looking form from almost any scanned image. 
With a little more patience, you can create an exquisite form from the ground up. Either way, 
EZ-Forms handles all the automation features, including pick-lists, field help, calculations, 
validations, etc.



Contents command (Help menu)

Use this command to display the opening Help screen. From here you can select any of the 
main help topic categories, including both instructional and reference information. Help is 
displayed by another program called WINHELP, which is provided with Windows.

At any time while in help, you can click the [Contents] button to return to the Contents screen.

Add your own notes to the help file by using Help's Edit-Annotate command or the Annotate 
toolbar button. All annotations are saved in the Windows program subdirectory as filename 
[program].ANN. These annotations can only be modified and viewed during display of this help 
file. As a reminder, annotated topics will display a paper-clip icon to the left of the topic title.



Insert Graphic (Edit menu)

Two image formats can be used by the Insert Graphic command.
• Bitmap (.BMP extension)
• Device Independent Bitmap (.DIB extension)

For other image formats and OLE object embedding feature, use the Edit-Insert New Object 
command.

Edit-Insert Graphic allows the image to be embedded into the form or linked to the form. Each 
method has its own advantages and disadvantages, as listed below. It is important to gain a 
thorough understanding of these two methods before deciding which is best for your situation.

Embedded

The graphic image will be copied into the form file. The original graphic file will no longer be 
needed by the form.

Advantages

••• The graphic is always available, even when the form is copied to another system
•• The original graphic can be changed without affecting this form

Disadvantages

• Larger form size
•• Changes to original graphic not automatically reflected in form

Linked

Only the graphic image file name will be saved in the form. The original graphic file will always 
be needed by the form.

Advantages

• Smaller form size
• Changes to original graphic reflected in form
• Multiple forms can use the same graphic file - disk space savings can be substantial

Disadvantages

• When copying the form to another system, graphic files must also be copied
• Graphic files must always be available when using the form



Insert Graphic    vs    Insert New Object

Insert Graphic has direct control of the image-to-form process.
Recommended for .BMP and .DIB image formats.

Insert New Object utilizes the OLE capabilities of Windows, thus requiring more processing 
and memory overhead.
Recommended for PCX, MSP and other image formats as well as multimedia video 
movies (e.g., .AVI) or sound clips (e.g., .WAV).

See Also

Change Graphic
Insert New Object
Acquire



Insert New Object (Edit menu)

Use this command to insert an OLE object from an OLE server application. The OLE server will 
become the active application until you exit or cancel the session.

Select the OLE object you want to insert into your form by using the Insert New Object dialog 
box. This command is only available in Design Mode.

Edit Paste can also be used to insert an OLE object. This assumes that first something was 
copied to the clipboard from a server application.

Insert New Object    vs    Insert Graphic

Insert New Object utilizes the OLE capabilities of Windows, thus requiring some performance 
and memory overhead.
Recommended for PCX, MSP and other image formats as well as multimedia video 
movies (e.g., .AVI), sound clips (e.g., .WAV) and other special formats.

Insert Graphic utilizes a more direct approach to images, but is more limited in file types 
supported.
Recommended for BMP and DIB image formats.

See Also

Inserting OLE Objects
Insert Graphic
Acquire



Insert New Object Dialog

Used to identify the object file and some associated attributes.

Create New:
Toggle ON to create a new OLE object and place it into the form, by choosing the OLE server 
that will maintain the object.

Create from File:
Shows the full path and file name of the object about to be created. When creation is complete, 
the object will be inserted into the form. Either enter the filename, or use the Browse button to 
locate the file you want.

File:
Shows the full path and file name of the object to be inserted into the form. Either enter the 
filename, or use the Browse button to locate the file you want.

Links:
Link an OLE object to the form. Unselect this item to embed the object in the form.

Display as Icon:
An icon representation is used for OLE objects that cannot be displayed, such as sound files. 
You can choose a different icon with the Change Icon button.

Result:
Helpful message displays appear after choosing a conversion type before committing to action.

Browse button
Select the file using the Browse dialog box to search through drives and subdirectories.



Insert Page (Form menu)

Create an associated page to the form. Add a new page before or after the current page if it is a 
single page form. Add new pages before or after the current, or to the beginning or end of the 
full set of pages.

See Also

Insert Page dialog box
Delete Page



Insert Page Dialog

This dialog box requires that you decide the position of the new page in relation to the full set of 
pages in the series. The display will change from the current page to the newly create page for 
design editing. Options are to add a new page as the first in the set, add a new page before or 
after the currently displayed page or add a new page as the last page in the set.

See Also

Insert Page
Delete Page



Installation
The installation process is accomplished by running the SETUP.EXE program present on disk 1 
of the distribution disks. SETUP copies the program and its support files, this help file and 
various other information files. When system files already exist on your system that are newer 
than identically-named files on the EZ-Forms distribution disks, SETUP will not overwrite the 
newer files. Installation and use of EZ-Forms must always follow the EZ-Forms License 
Agreement.

Command Line Options can be used to set up EZ-Forms as a form fillout program, allowing any 
number of Program Manager icons to be created for filling out forms that act as templates.

Here is a list of functional files that comprise the EZ-Forms product. This list may prove useful 
when troubleshooting any difficulties that may occur either during installation or when running 
the EZ-Forms program.

EZ-Forms Program Files

These files belong in the EZ-FormsFiller program directory since they are unique to EZ-
FormsFiller. Note: Filename may vary for each Fill-Only or TestDrive installations.

Registered Ver. TestDrive Ver.
(program).exe (program)td.exe
ezx1.dll ezx1.dll
(program).hlp (program)td.hlp
(program).hbr (program)td.hbr
(program).tip (program)td.tip

System Support Files

These files are in general use in the industry, and should reside in the Windows System 
directory, typically c:\windows\system.

ctl3d.dll
mfcoleui.dll
hbrowser.dll
hsearchr.dll

OLE Version 2 System Files

These files implement the Microsoft Windows OLE Version 2 system. As above, they are in 
general use and should reside in the Windows System directory. The regedit.exe program, 
which is part of Windows, must be present on your system during installation, to allow proper 
configuration of OLE 2.

compobj.dll
ole2.dll
ole2conv.dll
ole2disp.dll



ole2nls.dll
ole2prox.dll
storage.dll
typelib.dll
ole2.reg



 EZ-Forms XL/PRO       
The Professional Eforms Processor for Windows 95/NT/3.1x.

“Eforms”, Math, Pick/Help-Lists, Pop-Ups, Field Ordering, Multi-Pages, More!
Create, Modify, Scan, Fill-In, Navigate, Compute, Validate, Save, ANYFORM™

      

       

      EZ-
Forms

EZ-Forms XL/PRO™ & © 1994-97 by 
EZX Corporation
“The Forms Automation Company”

EZ-Forms™ is the Ultimate Forms Processor for Windows!

Create, Modify, Fill-in, Navigate, Save ANYFORM™ in minutes!

** EZ-Forms™
... the "EZ-Forms eXecutive"/SuperForms™ for Windows (3.1x & 95) is the Professional Forms 
Automation Processor!

** Create, Fill-Out (internal), Fill-In (pre-printed), Modify,
      Navigate, Save, Revise, ANY FORM in minutes!
    
** WYSIWYG, multiple open forms, cut/paste, protected
      fields/objects, much, much, more.

* Whether your business is small or large, you can easily
    and quickly Create and Fill any document,
    Fill-in (internally generated forms), Fill-out
    (pre-printed forms), Save, Save-as, Revise, and/or
    Print (even to FAX) all kinds of forms in minutes.

* Create custom forms (lines, boxes, etc.) on screen and
    add fill-out fields, and you're done!

* You can even fill-out pre-printed forms! Simply design an
    "overlay" form.

* EZ-Forms™ for Windows is here!!!

* EZ-Forms is GREAT FOR:
 * Perfect form fill-out.
 * Commercial Printers ... speeds form design, modification.
 * In house publication departments ... Improve response time,
      ease update process, cut costs.
 * Low cost forms development ... Develop and print all of your



      forms without outside help.
 * Printing any quantity of custom forms on your laser printer
      ... on demand!
 * Great for basic desktop publishing too!

* EZ-Forms' focus is on forms design, production and fill-out.
    Unlike page document composition, the logical object oriented
    drawing tools are specifically tailored and optimized for forms
    design and manipulation. Its WYSIWYG (what-you-see-is-what
    -you-get) interactive screen is clear, intuitive and easy to use.
    Font size,    typeface and printer options (including FAX transmission)
    are limited only by what is available under Microsoft Windows for your
    system.    For truly flexible forms production, you can even print the
    filled-in data and the form at the same time or, fill-out to
    pre-printed forms.

* You can easily customize any of the 100+ included form templates 
      to create any new form you desire.

*    DESIGN FORMS QUICKLY and EASILY:
      * Using the display screen and mouse, you can perform fully
          interactive forms composition by creating and manipulating
          various "objects". 
      * WYSIWYG means that the screen looks like the final printed
          from, showing typefaces, font sizes, lines, rectangles, 
          rounded rectangles, ellipses, circles, shading, logos, etc.
          Size any object for creative impact.
      * Text can be automatically word-wrapped, justified (left, 
          center, right, full), fonted, colored, etc. in any text
          or fill-out field. 

Other Form Design and Fill-out Features include:
* Extensive on-line help and MANUAL with BROWSE, TEXT SEARCH, PRINT.
    The Help file's powerful Browse and global Text search features (not available
    in "regular" Windows help files) will allow you to find any topic,
    word, or phrase quickly. You will also be able to print any topic
    or group of topics on demand. The unique "tree" structure gets you
    to your information fast. NEVER be without your manual again!
* On-screen grid (user adjustable; does not print) and
    snap-to-grid allow very quick and precise positioning of
    all objects and fields.
* Fill-out master or modify completed forms. No need to
    retype redundant information. 
* Open multiple forms at once for quick reference or cut-and-paste.
* Multiple form views can be full window, window cascade,
    tile view, or reduced to icons.
* Four different working view magnifications 25% to 300%
    are available for even the most intricate work.
* Precise continuous coordinate display for accurate positioning.
* Tool bar and status line control allow you to customize
    appearance and operation of the program.



* Copy, cut, and paste objects between multiple Eforms.
* Define page sizes, margins, layouts, orientation.
* Draw lines, boxes, shapes, fill patterns of many types,
    change orientation and color.
* 26 drawing tools are provided form design. There are five
    pen line styles, 10 thicknesses and eight brush patterns.
* Other drawing tools include rectangle, round rectangle, and
    ellipse which can be melded with any of the brush patterns. 
* Fill-out fields can be placed anywhere on the form, and in fill-out 
    mode, the master part (or background) of the form cannot be modified 
    so as to assure perfectly filled out forms every time.
* Print to any Windows supported device, even directly to your
    FAX/modem (third party drivers required) for immediate transmission
    of your form.
* Use any Windows font including Bar Codes, and special characters like 
    Wingdings.
* Quickly bold, underline, italicize, strike-through, etc. any text field.
* You can even paste text from your trusty ol' DOS programs via
    Window's clipboard.

*    in release 96gi/2.21 include:
* Multiple pages per form files with:

- Collated & Non-collated print options
- Next Page / Previous Page Toolbar buttons
- Insert Page / Delete Page menu options
- Page number in Status Bar

* Print Field Data Only - for use with pre-printed forms.
* Highlighted background (color is user adjustable) of any
    text or data input field.
* Auto-Popup field Help & Picklist ... Global setting or Individual fields.
* Tips of the Day quick access screen.
* Select and move multiple field names simultaneously in Fillout Order dialog box.

* New features in release 96cb/2.11 include:
* Direct TWAIN compliant scanner support.
* Full text justification option.
* Full zero suppression on calculated numeric fields.
* The ability to import any device independent bitmap
    from Window's clipboard.
* The ability to link graphic files to your forms (rather
    than embedding them) to save precious disk space.
* Numerous touchups.
* Enhanced field operations including:
    -Field Calculations (50+ math & logical)
    -Ordering (the way the cursor moves)
    -Pick lists (for quick data entry)
    -User help (unique field help eases entry questions)
    -Validation (imposes data entry limits)
    -Auto-date/time/number, etc.
* Multiple object selection for move, copy, paste, etc.
* Built-in support for MAPI (mail application programming interface)



    compatible Email (Electronic Mail).
* Support for international measurements and paper sizes. 
    Window's international settings are monitored and the appropriate defaults 
    are used. (ISO paper sizes and metric measurements, for instance)
* Unlimited character size for text objects. (Old limit was 256 characters.)
* Improved OLE functionality.
* Multiple copy printing.
* Graphics placement/sizing is faster via use of screen tokens.
* Screen updates are faster too.
* Immediate TD enhancement capability.
* EZ-Forms can save thousands of dollars in
    pre-printed forms and time, but ...

Ask about upgrade, competitive, and introductory pricing.

Also ask about custom design and “sub-publishing” services.

Special versions of EZ-Forms (using the EZ-Forms PRO Filler engine) specifically tied to 
custom developed forms, are the “engines” that drive products like ExportPower PRO™, 
WinDD250 PRO™, FormTrooper™, EZ-MSDS™, PackageTrakker™, YourForms PRO™, 
WinSF171™, AnyPower™, MedTrakker™, ExpenseTrakker™, etc. Call for details.

Should you require a special re-distributeable edition of EZ-Forms XL, it is known as EZ-Forms 
PRO and is available in Site, Corporate, and Developer's editions.

* Call for Multi-user, LAN, Server, Site,
    Corporate and Developer's licensing and
    extended support. (EZ-Forms PRO)

Specifications, pricing, etc. are subject to change without notice.

Copyright © 1994-97, All rights reserved by:

EZX Corporation
“The EZ-Forms Automation Company”
917 Oakgrove Drive, Suite 101
Houston, TX      77058-3046      USA

Technical Support:
Voice: +1-281-280-0080 

(9:00am - 4:00pm    Central    USA    M - F)
Internet: support@ez-forms.com    or    

EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
World Wide Web: http://www.ez-forms.com

For all other business and International:
Voice: +1-281-280-9900 

(Questions, Comments, observations, & support.)



FAX: +1-281-280-0099 
(Inbound FAXes; 24hrs per day.)

• Credit Card Orders (Visa, MasterCard, Discover, American Express) at:
    Voice Order Desk: 1.800.800.2H4O6T8

 (toll free in the USA; support/service calls will incur a service charge))
    FAX Order Desk: 1.800.F3A2X9.2H4O6T8

 (toll free in the USA; All other correspondence, etc. will be ignored.)

(There is a per-minute charge for service/support calls to the above number.)

Shipping & Insurance:
$14 USA-48 for 2nd business day shipping. $2 for each additional item.
$24 USA-48 for Next Business day shipping. $4 for each additional item.
$19 USA-AK/HI/PR/VI/GU/AS; Canada (all provinces). $3 for each additional item.
$24 Elsewhere. $4 for each additional item.
• You can request whatever shipping you wish, such as your own FedEx number, for actual cost
plus $7 handling charge per order.

Pricing, etc. are subject to change without notice. Contact EZX if this information is over
6 months old.



Keyboard Commands
Text and Field Edit Objects

Arrow keys Cursor movement
Home Beginning of line
End End of line
Ctrl + Home Beginning of text
Ctrl + End End of text
Ctrl + Left Previous word
Ctrl + Right Next word
Shift Add to any above key to select text
Insert Toggle insert / overstrike mode
Delete Delete a character to the right
Enter Terminate text entry
Ctrl + Enter Force new line
Alt + Backspace
or Ctrl + Z

Undo

Fillout Mode
Arrow keys Cursor movement
Tab Next field (Options-Preferences-Tab between 

fields toggled ON)
Shift + Tab Previous field (Options-Preferences-Tab between

fields toggled ON)
Enter Next field
Shift + Enter Previous field

Form / Window Movement
PageUp Scroll up page
PageDown Scroll down page
Ctrl + PageUp Scroll left page
Ctrl + PageDown Scroll right page
Ctrl + Home To First field
Ctrl + End To Last field
Ctrl + Up Scroll up line
Ctrl + Down Scroll down line
Ctrl + Tab Switch between open form windows.

Design Mode
Arrow keys Micro-Move selected object
Shift + Arrow keys Move selected object
F2 Turn ON / OFF snap-to grid

(see Options-Defaults-Grid)

Menu Hot Keys
Ctrl + Key combinations:

Ctrl + N File - New
Ctrl + O File - Open
Ctrl + F File - Fillout



Ctrl + S File - Save
Ctrl + P File - Print
Ctrl + X Edit - Cut
Ctrl + C Edit - Copy
Ctrl + V Edit - Paste
Ctrl + E Edit - Text
Ctrl + Z Edit - Undo Delete
Ctrl + T Edit - Text Feed - Time
Ctrl + D Edit - Text Feed - Date
Ctrl + R Refresh Screen to eliminate screen movement 

artifacts.
Ctrl + F4 Form Control - Close
Ctrl + F6 Form Control - Next

Alt + Key combinations:
Alt + F4 Program Control - Close
Alt + Backspace Edit - Undo Delete



LDEXP(num,num)
Description Calculates binary exponents.

Syntax LDEXP(x, exp)

x and exp are any valid numbers.

Remarks Returns the value of x * (2 raised to the power of exp).

Examples LDEXP(2, 1) returns 4.

LDEXP(5, 2) returns 20.



LOG10(num)
Description Calculates the base-10 logarithm of a number.

Syntax LOG10(number)

number is any positive real number.

See Also EXP and LOGN functions

Examples LOG10(260) returns 2.41

LOG10(100) returns 2



LOGN(num)
Description Calculates the natural logarithm of a number.

Syntax LOGN(number)

number is any positive real number.

See Also LOG10, EXP and E functions.

Examples LOGN(10) returns 2.30.

LOGN(2) returns 0.69.



LOWER(char)
Description Changes the uppercase alphabetic characters in the specified string to lowercase
characters. All other characters in the string are unaffected.

Syntax LOWER(char)

char is any string.

See Also PROPER and UPPER functions

Examples LOWER("3rd Quarter") returns "3rd quarter"

LOWER("JOHN DOE") returns "john doe"



LTRIM(char)
Description Removes all blanks at the beginning (left side) of a character string.

Syntax LTRIM(char)

char is any text string.

See Also RTRIM function

Examples LTRIM("          ") returns "" (empty character string)

LTRIM("    Andy      ") returns "Andy        "



Form Layout Dialog

When creating a form with the File-New command, these settings will only apply to the new 
form.

The layout of a form can be altered after creation by using the Form Form Layout command, 
accessible from the main menu. The dialog box title will not include "Defaults" when modifying 
an existing form.

Choose form size, orientation and margin settings. When accessed via Options Defaults Form 
Layout, the layout will only affect newly created forms. All of these settings can be changed after
form creation.

Form Size:
Choose a pre-defined or user-defined form size. Set form orientation (Portrait or Landscape) to 
match intended page printing. User-defined sizes are entered in the "Size" area below. Pre-
defined choices are:

Letter 8.5 x 11 in
Legal 8.5 x 14 in
11 x 17 in
A3 29.7 x 42.0 cm
A4 21.0 x 29.7 cm
A5 14.8 x 21.0 cm
B4 25.0 x 35.4 cm
B5 18.2 x 25.7 cm
Fanfold 8.5 x 12 in
Fanfold 8.5 x 13 in

Units:
For measurement units, EZ-Forms accepts numbers up to two decimal places. When modifying 
a form, units can be changed for informational purposes only. Units always revert back to the 
setting made in the Options Defaults Form Layout dialog.

Units will default to the Windows International settings.

Margins:
Represents blank areas at all four edges of the form. Margins can be viewed through Print 
Preview.

Margin settings for the page are not shown as part of the display during form design. However, 
the Status Bar coordinate display does include these margins.

Size:
For pre-defined sizes, the settings are not changeable and reflect the currently chosen form 
size. When a user-defined form size is chosen, these sizes can be set. When printing, make 
sure the printer settings match the intended printing orientation, either portrait or landscape. 
Accepted values are 2.00 through 30.00.





EZ-Forms License Agreement
NOTE: The following agreement is meant for a single-user / single-machine use of
EZ-Forms.
• If you have multi-machine, network, site, Developer or Corporate licensing 
needs, contact EZX's sales department at the numbers below.

The EZ-Forms program series and all of its components are protected by United States 
Copyright Law and International Treaty provisions. All worldwide rights are reserved.

Copyright ©1994-97 All Rights Reserved
Distributed by:      EZX Corporation
“The Forms Automation Company”

P. O. Box 58177, Webster, TX 77598-8177 USA
Phones: Voice:+1.281.280•9900      FAX:+1.281.280•0099

Tech:+1.281.280•0080

LICENSE/REGISTRATION STATEMENT (This does not apply to TestDrive versions which are 
licensed for 15 day trial use.): The EZ-Forms (PROGRAM) is protected by United States 
Copyright Law and International Treaty provisions. All rights are reserved. You may use this 
program as indicated in the serial number, license/registration agreement, and purchase receipt,
on a single machine. (Your hard copy license/registration card may indicate authorization for 
multiple-machines or a network for the stated amount of users. If this is the case, that card 
supersedes this license statement with regard to a single user.). EZX Corp. hereby grants a 
“book” license to the original individual user (even if purchased by a company or other 
organization) of this copy of EZ-Forms. You may use the program on your computer and make 
one backup copy, as long as there is no possibility of use or residence on more than one 
machine at any time. Just like two people cannot read the same book in different locations at 
the same time. Use of any kind by a single user version on a Local Area network is prohibited. 
Every copy of EZ-Forms has a unique serial number embedded within it, for traceability. You 
may not make, sell, or give copies of this program and documentation to anyone. No 
exceptions. EZX Corp. makes no warranty of any kind, expressed or implied, including (without 
limitation), any warranties of merchantability and/or fitness for a particular purpose. EZX Corp. 
shall not be liable for any damages, whether direct, indirect, special or consequential arising 
from a failure of this program to operate in the manner desired by the user. EZX Corp. shall not 
be liable for any damage to data or property which may be caused directly or indirectly by use of
the program. EZX Corp. makes no claims, offers no warranties, and assumes no responsibility 
for any sort of damage (mental or physical) resulting from the apparent or actual use of our 
products. Any text files, printer control files, or forms provided with this product are not 
guaranteed as to merchantability or fitness for its ultimate use. User accepts all responsibility for
use and may not resell any supplied text file, printer control file or form. A person, business, 
corporation, government organization or any other entity, to do so is strictly forbidden from using
unregistered copies of this program and, is a violation of this license agreement. EZ-Forms may 
not be distributed in conjunction with any other product, without written permission from EZX 
Corp. The License Agreement and statement shall be construed, interpreted and governed by 
the laws of the United States of America and the state of Texas.

All pricing, terms and conditions are subject to change without notice. Some of the terms used 
within this document are trademarks of the following firms: International Business Machines, 



Sony, Microsoft, Lotus Development Corp., Intel Corporation. Etch-a-Sketch is a registered 
trademark of Ohio Art.

EZ-Forms PRO, EZ-Forms PRO Filler, EZ-Forms XL, FormPower PRO, FillPower PRO, 
HotFormz PRO FormEZ, EZ-Forms Gold, EZ-Forms, EZ-Forms Lite, SuperForms, SuperForms 
PRO, PF, EZ-Forms Plus, EZ-Forms eXecutive, EZ-Forms DataBase, EZ-InFORMa dB, EZX-
Word, EZ-Spreadsheet, EZ-DiskCopy PRO, etc. are trademarks of EZX Corporation. Revised 
01/97.    ©1994-97 EZX.



Line command (Draw menu)

Line Drawing tool. Activate by clicking on the Line Toolbar button, or by selecting the Draw-Line 
command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a line to the 
desired length.
3) Release the mouse button when done.

When the Snap-to-Grid option is selected in the Grid dialog box, the line's end points will "snap" 
to the nearest grid points.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



EZ-Forms Logo and Icon is Copyright © 1994-97 and Trademark ™ by EZX 
Corporation.

Thank you for using EZ-Forms™ for Windows © 1994-97 by and from:    (All rights 
reserved.)

EZX Corporation
“The EZ-Forms Automation Company”
917 Oakgrove Drive, Suite 101
Houston, TX      77058-3046      USA

Technical Support:
Voice: +1-281-280-0080 

(9:00am - 4:00pm    Central    USA    M - F)
Internet: support@ez-forms.com    or    

EZXHOU@aol.com
AmericaOnLine: EZXHOU (E-mail)
World Wide Web: http://www.ez-forms.com

For all other business and International:
Voice: +1-281-280-9900 

(Questions, Comments, observations, & support.)
FAX: +1-281-280-0099 

(Inbound FAXes; 24hrs per day.)

• Credit Card Orders (Visa, MasterCard, Discover, American Express) at:
    Voice Order Desk: 1.800.800.2H4O6T8

 (toll free in the USA; support/service calls will incur a service charge))
    FAX Order Desk: 1.800.F3A2X9.2H4O6T8

 (toll free in the USA; All other correspondence, etc. will be ignored.)

(There is a per-minute charge for service/support calls to the above number.)

Special versions of EZ-Forms (using the EZ-Forms PRO Filler engine) specifically tied to 
custom developed forms, are the “engines” that drive products like ExportPower PRO™, 
WinDD250 PRO™, FormTrooper™, EZ-MSDS™, PackageTrakker™, YourForms PRO™, 
WinSF171™, AnyPower™, MedTrakker™, ExpenseTrakker™, etc. Call for details.

Should you require a special re-distributeable edition of EZ-Forms XL, it is known as EZ-Forms 
PRO and is available in Site, Corporate, and Developer's editions.

* Call for Multi-user, LAN, Server, Site,
    Corporate and Developer's licensing and
    extended support. (EZ-Forms PRO)





MAX(num,num)
Description Returns the largest value of 2 numbers.

Syntax MAX(num1, num2)

num1 and num2 are any valid numeric values.

See Also MIN    function

Examples MAX(50, 500) returns 500

MAX(3, -10000) returns 3



MAXEXP()
Description Provides the largest possible exponent for a number.

Syntax MAXEXP()

Remarks Returns the largest possible number that can be used for an exponent when 
entering a numeric value. This value is platform-specific. For Windows 3.1 it 
is 38.

See Also MINEXP function and Constants



MAXVAL()
Description Provides the largest possible value for a number.

Syntax MAXVAL()

Remarks Returns the largest possible number that can be represented. Larger 
numbers are truncated or will cause errors. This value is platform-specific. 
For Windows 3.1 it is 3.4028234660E+038

See Also MINVAL function and Constants



MIN(num,num)
Description Returns the smallest value of 2 numbers.

Syntax MIN(num1, num2)

num1 and num2 are any valid numbers.

See Also MAX function

Examples MIN(50, 200) returns 50

MIN(field001, field023) returns the smallest value from both fields



MINEXP()
Description Provides the smallest possible exponent for a number.

Syntax MINEXP()

Remarks Returns the smallest possible number that can be used for an exponent when
entering a numeric value. This value is platform-specific. For Windows 3.1 it 
is -37.

See Also MAXEXP function and Constants



MINVAL()
Description Provides the smallest possible value for a number.

Syntax MINVAL()

Remarks Returns the smallest possible number that can be represented. Smaller 
numbers are truncated or will cause errors. This value is platform-specific. 
For Windows 3.1 it is 1.1754943510E-037.

See Also MAXVAL function and Constants



MOD(num,num)
Description Returns the remainder after dividing a number by a specified divisor.

Syntax MOD(number, divisor)

number is any number.
divisor is any non-zero number. If divisor is 0, an error will result.

Examples MOD(-23, 3) returns -2

MOD(-23, -4) returns 3



Maximize button

The Maximize button for a form window will expand the window to full EZ-Forms client window 
size and set the currently active window display to be the default until changed.

Shortcut
Mouse:

Click on the maximize icon  on the title bar, or 
double-click the title bar.



Minimize button

The Minimize button of a form window will iconize the active window and display the icon within 
the EZ-Forms client area, usually at the bottom.

Shortcut
Mouse:

Click the minimize icon  on the title bar.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog 
box with the arrow keys.

Note:    This command is unavailable if you maximize the window.



New command (File menu)

Use this command to create a new master form. The Form Layout dialog box will appear to 
allow selection of form dimensions and margins.

You can open an existing master or fillout form with the Open command.

Shortcut
Toolbar:
 Keys: Ctrl + N



Next Window command (Form Control menu)

Use this command to switch to the next open form window. EZ-Forms determines which window
is next according to the order in which you opened (or last edited) the windows.

Shortcut
Keys: Ctrl + F6



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Change Source Dialog

Change the selected link to receive data from another application, file, or item.

Source:
This area of the dialog box shows a listing of files available in the current subdirectory. If a tab is
in the scroll bar at the right edge of this area, use it to scroll through the file listing. Use 'List File 
of Type' to quickly choose what file types to show. Enter wildcard file names to control what files 
are shown.

Directories:
This section indicates the current subdirectory. Use the section below to change to a different 
subdirectory. Change subdirectories by using the scroll bar or double-clicking on a directory 
name. If a directory is not shown it may be located as a subdirectory below the one just above 
the current subdirectory. Try double-clicking on a directory name that is one or two levels above 
the current subdirectory.

List Files of Type:
Click on the arrow to change the type of files listed in the section just above.

Drives:
Click on the arrow to display other available drives.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version does not support network drive or services access, even though
the Network button may be active.



OLE Links command (Edit menu)

Use this command to display a    Links dialog box which lets you edit OLE links between your 
form and other documents.

This command is only available in Design Mode, and only available when you have at least one 
link in your form.

See Also

Inserting OLE Objects



OLE Links Dialog

Manage all OLE links. The following options are available in the Links dialog box:

Links:
Displays all links in the form. For each link it displays the filename, type and status of link.

Source:
Indicates drive path and filename of object.

Type:
Indicates type of image.

Update:
Select the type of link you want for the currently highlighted link.
Automatic Inserts new data as soon as it is available.
Manual Inserts new data only when you ask for it by choosing the Update Now button.

Update Now button
Updates all links selected in the Links box, and then closes the dialog box.

Open Source button
Opens the source of a selected link. For example: choosing the Open Source button opens up a
linked chart in Lotus 123 for Windows or Microsoft Excel if you have either chart linked to your 
form.

Change Source button
Change the selected link using the Change Source dialog box to receive data from another 
application, file, or item. 

Break Link button
Breaks links for all selected links between data and the form, and then closes the Links dialog 
box.



Object Convert Dialog

This dialog can vary greatly depending on what OLE server applications are available on your 
system. An OLE object can only be converted when there is another compatible object type 
available.

Current Type:
Identifies the type of object currently selected.

Convert to:
If available, select this option to change the OLE object type.

Activate as:
If available, choose a different OLE server to associate with the object.

Object Type:
Lists the available choices to convert the object to.

Display as Icon:
An icon representation is used for OLE objects that cannot be displayed, such as sound files. 
You can choose a different icon with the Change Icon button.

Results:
Helpful message displays appear after choosing a conversion type before committing to action.



Object Change Icon Dialog

Change the icon representation used by an object 

Icon
Current:
Displays the currently used icon for the object.

Default:
Select the default icon as the one to associate with this OLE object.

From File:
Select an icon from any .ICO, .EXE, LIB or .DLL icon library. Images of available icons stored 
within the library file are displayed below.

Label:
You can modify the label used beneath the icon.

Note:    The active Icon is displayed in the bottom right corner of the dialog box.

Browse button
Select the file using the Browse dialog box to search through drives and subdirectories.



Object Insert Browse Dialog

Locate existing files for use as objects on the form.
This dialog is the File Open common dialog used in most Windows programs.

Source:
This area of the dialog box shows a listing of files available in the current subdirectory. If a tab is
in the scroll bar at the right edge of this area, use it to scroll through the file listing. Use 'List File 
of Type' to quickly choose what file types to show. Enter wildcard file names to control what files 
are shown.

Directories:
This section indicates the current subdirectory. Use the section below to change to a different 
subdirectory. Change subdirectories by using the scroll bar or double-clicking on a directory 
name. If a directory is not shown it may be located as a subdirectory below the one just above 
the current subdirectory. Try double-clicking on a directory name that is one or two levels above 
the current subdirectory.

List Files of Type:
Click on the arrow to change the type of files listed in the section just above.

Drives:
Click on the arrow to display other available drives.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version does not support network drive or services access, even though
the Network button may be active.



Object verb (Edit menu) 

Design Mode

The Edit Object command opens the OLE server application that has been selected to maintain 
the object. The object is automatically loaded into the OLE server. This command is available 
only when you have selected an existing OLE object. You will be in another application, not EZ-
Forms, while you edit the object. When you finish editing, choose File-Update in the OLE server 
application menu. EZ-Forms then incorporates the changes into your form. This menu's name 
changes depending on the object you select.

The Object Convert command opens the Convert dialog box.

There may be more than one verb listed. The first listed verb is always the Primary Verb, and 
the remaining are Secondary Verbs. The actual commands depend on the OLE server for the 
object. For example, the Media Player program that is part of Windows lists Play as the Primary 
and Edit as the Secondary Verb.

Fillout Mode

The Primary verb is available in Fillout Mode by double-clicking on the object with the mouse left
button.

Shortcut
Mouse: Double-click the object with

the left mouse button.



Open command (File menu)

Use the Open command to open an existing form in a new window. You can open multiple forms
at once. Use the Window menu to switch among the multiple open forms. See Window 1, 2, ... 
command.

Choose Fillout to open a form containing fields for data entry.

Select the name of the form you want to open in the Open dialog box.

You can create new forms with the New command.

Note: The single user, non-network version of EZ-Forms will not read-from or save-to a network
drive.

Shortcut
Toolbar:
Keys: Ctrl + O



Operators
Operators are used to build Expressions.

Operator Symbol Precedenc
e

Type Comments

Add + 5 Numeric, 
Date

Subtract - 5 Numeric, 
Date

Multiply * 6 Numeric
Divide / 6 Numeric
Exponentiate ^ 7 Numeric X^Y means X to the Yth
Concatenate I + 5 Character Straight Concatenate
Concatenate II - 5 Character Concatenate, spaces on 

end
AND .AND. 3 Logical
OR .OR. 2 Logical
NOT .NOT. 1 Logical
Greater Than or 
Equal To

>= 4 Logical Any type except logical

Less Than or 
Equal To

<= 4 Logical Any type except logical

Greater Than > 4 Logical Any type except logical
Less Than < 4 Logical Any type except logical
Equal To = 4 Logical Any type
Not Equal To <> 4 Logical Any type
Is Contained In $ 4 Logical Character only

Operators have a precedence which specifies operator evaluation order. The higher the 
precedence, the earlier the operation will be performed. For example, Divide has a precedence 
of 6 and Plus has a precedence of 5 which means Divide is evaluated before Plus. 
Consequently, 7+8/2 is 11. Evaluation order can be made explicit by using parenthesis. For 
example, 1+2*3 returns 7 and (1+2)*3 returns 9.



Overview
EZ-Forms is a forms processor, making the creation and fill-out of forms simpler and easier than
it would be if you were using any other kind of program. EZ-Forms takes the best features from 
word processing, desktop publishing and spreadsheets, and combines them to create a forms 
processor that avoids the complexity of any other solution.

EZ-Forms is organized into two modes of operation, Design and Fillout. Your interaction will be 
in one of these modes at any given time. This Overview is meant to help you understand the 
EZ-Forms user interface, including menus, toolbars, icons, etc.

Design Mode Overview
Master forms are created in Design Mode. A master form can be printed for fillout by hand, or it 
can be filled out within EZ-Forms in the Fillout Mode. The master form file extension is .frm. 
When creating a master form for fillout with EZ-Forms, numerous features can be used to make 
fillout quicker, easier and more accurate.

Fillout Mode Overview
A master form is filled out in EZ-Forms, which creates a filled-out form. The filled-out form file 
extension is .fof. None of the Design Mode functionality is available during fillout, thereby 
avoiding problems with inadvertent modification of headings, borders, etc.



Overview command (Help menu)

Use this command to display the Overview Help screen. The Overview is meant to help you 
understand the EZ-Forms user interface, including menus, toolbars, icons, etc.

At anytime during Help, you can click the [ Contents ] button to return to the opening screen.

Add your own notes to the help file by using Help's Edit Annotate command or the Annotate 
toolbar button. All annotations are saved in the Windows program subdirectory as filename 
[program].ANN. These annotations can only be modified and viewed during display of this help 
file. As a reminder, annotated topics will display a paper-clip icon to the left of the topic title.



PI()
Description Returns the value of the mathematical constant pi, which is approximately 
3.14159265358979 when calculated to 15 significant digits.

Syntax PI()

See Also COS, SIN and TAN functions



POW(num,num)
Description Exponentiates a number, which is the function form of the ^ operator.

Syntax POW(x, y)

x and y are any valid numeric values.

Remarks Returns the numeric value of x raised to the power of y.

See Also ^ operator.

Examples POW(5, 2) returns 25

POW(2.7, 3.5) returns 32.34



PROPER(char)
Description Returns the specified string in proper-case format.

Syntax PROPER(char)

char is any character string.

Remarks In proper-case format, the first alphabetic character in a word is capitalized. If
an alphabetic character follows a number, punctuation mark, or space, it is 
capitalized. All other upper case alphabetic characters are converted to lower 
case. No other characters are affected.

See Also LOWER and UPPER functions

Examples PROPER("cOrporation") returns "Corporation"

PROPER("JOHN DOE") returns "John Doe"



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents into the form. This command is 
unavailable if the clipboard is empty.

When pasting an object, the new object is placed at a position similar to the original object. The 
new object is also automatically selected.

The Cut and Copy commands can place text or objects into the clipboard. The Paste command 
then places a copy of the current clipboard contents into the form, even when the clipboard 
contains text or objects that were copied or cut from another form. Text and OLE objects can be 
copied from other applications.

Shortcut
Toolbar:
Keys: Ctrl + V



Pen command (Form menu)

Modify line or border attributes for the selected object by using the Pen command in the Form 
menu or the object popup menu. This displays the Pen dialog box.



Pen command (Options-Defaults menu)

Settings assigned in the Options-Defaults-Pen dialog box are used to set defaults for all newly 
created line, rectangle, rounded rectangle and ellipse objects. Existing objects are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Pen Dialog

Choose line thickness, style and color for Line, Rectangle, Rounded Rectangle and Ellipse 
objects. When accessed with the Options-Defaults-Pen menu, pen selections will only affect 
newly created objects.

The pen characteristics of an object can be altered after placement by using the Form Pen 
command, accessible from the main menu or the object popup menu. The dialog box title will 
not include "Defaults" when modifying an existing object.

Thickness:
Adjust line thickness. Accepted values are 1 through 10.
For non-solid lines, thickness is fixed to 1.

Style:
Adjust the appearance of the line. The Five choices available are:
Dash
DashDot
DashDotDot
Dot
Solid

Note that line thickness is fixed to 1 for any non-solid line.

Pen Color button
Access the Color dialog to choose from a given color set.



Pick command (Field menu)

When a pick list exists for the current field, this command will display that pick list, allowing a 
chosen item to be quickly placed into the field. A pick list is created by the form designer in order
to make form fillout quicker and more accurate. It is usually best to choose from an existing list 
rather than type it in, since errors can result even in the simplest cases.

The pick list is presented in a dialog box, where a selection can be made with the keyboard or 
via mouse clicks. To use the keyboard, select the item with the up/down arrow keys then press 
Enter. With the mouse, either double-click on the item, or single-click on the item and then click 
on the OK button.

Shortcut
Toolbar:
 Keys: Ctrl + L



Pick List

Choose one of the items in this list for entry into the current field. You can select the item using 
a mouse click or arrow keys, or you can directly double-click on your selection.

The list presented here was created by the form designer to help during fillout. Whenever a pick 
list is present it is best to use it, as this leads to more consistent and accurate form fillout.

Shortcut
Toolbar:
 Keys: Ctrl + L



Preferences command (Options menu)

The settings assigned in the Options-Preferences dialog box are used to set defaults for 
program operations. These settings determine the way master forms and filled out forms 
function as you use them.

This is also where you can assign two custom view scale (25-300%) settings available in the 
View menu.

All options are saved into the .INI file with the Options-Save Settings command.



Preferences - All Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start EZ-Forms.

Custom Sizes:
The display scale you indicate here will be listed in the View pulldown menu.

Note:  Two of the view settings selectable from the View pulldown menu are user definable. 
Default settings for these custom view scales are defined by selecting Options-Preferences.

Four standard viewing scales are selectable from the pulldown menu and three of the most 
commonly used are available on the Toolbar. Two additional custom scales are user definable in
the Options-Preferences dialog box and are displayed in the View pulldown menu.

The two custom scales can be adjusted to settings you prefer. In the Options-Preferences dialog
box there are two fill in areas where you define the view settings. Accepted values are 25% 
through 300%.

Smooth Display:
The Smooth Display view option affects aesthetics only. It allows user control of a tradeoff 
between display flicker and speed. When off, the EZ-Forms display is faster, but objects can 
flicker as they are moved. When on, the display is slower, but no flicker occurs. The Smooth 
Display term represents a flicker-free display.

Personal preference and program usage will dictate this setting. Turning off Smooth Display 
during form design allows faster object movement. During fillout, the difference is less 
noticeable and less beneficial.

Color Correct Display:
This option only applies to color images. Windows allows each program control over a single 
system-wide palette of colors. When switching from EZ-Forms to another program, this palette 
can change to reflect the other program's specific requirements. When changing back to EZ-
Forms, if the palette was changed in the other program, a possibly time consuming color 
correction is done. This color correction on return to EZ-Forms is not performed when this 
option is off. This can cause color images to appear color-distorted. In any case, color printouts 
will be unaffected.

Text & Field Edit Background Color:
This option is used to change the background color when editing either a text block in design 
mode or when entering data into fields in fillout mode. If you chose a color for Text & Field Edit 
Background you may find that your choice is not activated. Select a brighter color than the one 
you just chose and refer to the troubleshooting section.

See Also

Main Tab



Fillout Tab
Master Tab



Preferences - Fillout Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start EZ-Forms.

Display coordinates:
The position of the Pointing Device (mouse) cursor will be displayed on the Status bar while in 
fill out mode.

Tab between fields:
When ON, the Tab key will move data entry to the next field, and the Shift+Tab key will move 
data entry to the previous field.
Shift+Enter is always available to move data entry to the previous field. Enter always moves to 
the next field. For multi-line fields, only from the bottom line will Enter move to the next field.

Toolbar:
Toggle On or Off the toolbar display that appears in the active form window. When entering data
into a filled-out form (.fof extension) the Fillout Mode toolbar is normally displayed.

Auto Popups
Global setting options can force the display or disable any popup in any form. To active 
automatically when the cursor moves into the field set for Always. To Disable the display of all 
popups set for Never. You do have the option of leaving the global setting as Normal and the 
popup can be displayed by pressing Ctrl + H for help or Ctrl + L for lists. Setting the auto-popup 
feature for specific fields only will cause the popup to activate automatically if feature is toggled 
on in the    Form-Field Setup    dialog box. When setting an Auto Picklist for a field, the list is 
displayed over the form and may hide the field's label or question. You may want to enter at the 
top of the list the label or the question that the use will be answering.

See Also

Main Tab
All Tab
Master Tab



Preferences - Main Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start EZ-Forms.

Toolbar:
Toggle On or Off the main Program toolbar display that appears just below the pull down menu. 
This toolbar remains available for both form design and fillout operations.

Status Bar:
Toggle On or Off the Status Bar displayed at the bottom of the program's window. Information 
such as instant help lines, mouse coordinates, type of active form and keyboard toggles are 
displayed.

See Also

All Tab
Fillout Tab
Master Tab



Preferences - Master Tab

Sets defaults for various program operating parameters. You may temporarily change settings 
during the current session without saving them (Options-Save Settings). In this case, the 
original settings will be used next time you start EZ-Forms.

Display coordinates:
The position of the Mouse will be displayed on the Status bar while in design mode.

Remember drawing tool:
When OFF, once an object is placed after selecting a drawing tool, the tool is deselected and 
select mode will automatically activate. This is indicated by the mouse cursor changing from a 
crosshair to an arrow. However, this automatic drawing tool deselection can be cumbersome 
when placing multiple objects with the same tool.
When ON, the drawing tool is not automatically deselected, so another object of the same type 
can be immediately placed.

View Fields:
When OFF, fields are shown in design mode the same way they will be shown in fillout mode. 
This means that borderless fields will be completely invisible unless selected. In fillout mode this
is acceptable since the user will be using Enter or Tab to move to the next field. In design mode,
fields aren't always apparent, but they also will not clutter the master form.
When ON, fields are indicated with a black border wrapped around the field's name. This is 
probably most desirable when placing, moving and resizing fields.

Toolbar:
Toggle On or Off the toolbar display that appears in the active form window. When creating or 
modifying a master form (.frm extension) the Design Mode toolbar is normally displayed.

See Also

Main Tab
All Tab
Fillout Tab



Print command (File menu)

Use this command to print a form. Presents a Print dialog box, where you may specify number 
of copies, destination printer, and other printer setup options.

Note: Make sure your printer landscape or portrait setting corresponds to the size and type of 
your form.

Shortcut
Toolbar:
Keys: Ctrl + P



Print Dialog

The following options allow you to specify how and where the form is printed.

Printer:
This is the active printer and printer connection. Choose the Setup option to change the printer 
and printer connection.

Print Range:
Specify the pages you want to print:
All        Prints the entire form.
Selection        Prints the currently selected text.
Pages        Prints the range of pages you specify in the From and To boxes.

Print Quality:
Select the quality of the printing. Generally, lower quality printing takes less time to print.
Available choices are:
High
Medium
Low

Copies:
Specify the number of copies you want to print for the above page range.

Collate Copies:
Prints copies in page number order, instead of separated multiple copies of each page.

Setup button
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Progress Dialog
The Print Progress dialog box shows the an progress display while EZ-Forms is sending output 
to the printer. To abort printing, choose Cancel.



Print Fields (File menu)

When a form has data fields that match precisely the position for data on a pre-printed form the 
electronic form is referred to as a Clear-Forms-Overlay (CFO).

Use EZ-Forms to create a form that closely resembles the original pre-printed form. The form 
should print both the static form design and its data. When completed, enter some test data in 
each field in fillout mode and print the form. Check the positioning of the data fields with a pre-
printed form by holding them together between you and a light source. Go back to form design 
mode in the master form and reposition any fields to match that of the pre-printed form. Then 
align any static form text that may appear out of adjustment to the data field positions.

With this type of form design you will have the option to print with static form text or send only 
the data to a printer that has pre-printed forms loaded in its paper tray. At print time, select File-
Print for both static text and data to be printed, or select File-Print Fields for the data only to be 
printed.



Print Preview command (File menu)

Use this command to preview how the active form will look on paper. This can minimize the 
amount of paper used to print out intermediate copies during Master Form design.

When you choose this command, the main window will be replaced with a print preview window.
The Print Preview toolbar offers you selections that change the view; move back and forth 
through the form; zoom in and out of pages; and can even initiate a print job.

Shortcut
Toolbar:



Print Preview Toolbar

Access the Print dialog box to start a print job.

Unsupported. Preview the next page.

Unsupported. Preview the previous page.

Unsupported. Preview one or two pages at a 
time.

Take a closer look at the page. (Make it bigger on
screen. Less of the page appears on screen with 
higher resolution.)

Take a larger look at the page. (More of the page 
appears on screen with lower resolution.)

Return from Print Preview to the main window.



Print Progress Dialog

The Printing dialog box is shown while EZ-Forms is sending output to the printer. The copy 
count and/or page number indicates the printing progress.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. Presents a Print Setup dialog 
box where you specify the printer, its connection, and page orientation.



Print Setup Dialog

The following options allow you to select the destination printer and its connection.

Printer
Default Printer:
Choose the Default Printer as defined in the Windows Control Panel setting.
Specific Printer:
Choose a Specific Printer from one of the currently installed printers shown in the box. You may 
install other printers and configure ports (LPT1:, etc.) using the Windows Control Panel.

Orientation
Portrait:
This is normal orientation, where text is printed in the natural page orientation for the printer. For
example, an 8.5" wide by 11" high form would be printed in Portrait orientation on a LaserJet 
printer.
Landscape:
This orientation prints text 'sideways' on a page. For example, an 11" wide by 8.5" high form 
would be printed in Landscape orientation on a LaserJet printer.

Paper
Size:
Select the size of paper that the form is to be printed on.
Source:
Some printers offer multiple trays for different paper sources. Specify the tray here.

Options button
Displays a dialog box where you can make additional choices about printing, specific to the type
of printer you have selected. This dialog is presented by the selected printer's driver, which has 
full control over any printer-specific options. Printer drivers are provided by Microsoft and/or the 
printer manufacturer.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version does not support network drive or services access, even though
the Network button may be active.



Printable command (Form menu)

Any object placed on the form can either be Printable (visible on screen as well as paper 
printouts) or Non-Printable (visible only on screen and not printed).

Form-Printable
Selecting this item will toggle on or off the printable attribute for the currently selected text, field, 
or graphic object. This command is also accessible from the object popup menu.

You can also use this feature to insert special instructions or notations in your form that will 
never be printed.

HINT: Each object can be set to printable or non-printable at any time with the Form-Printable 
command.

Options-Defaults-Printable
With this option toggled On (check mark visible) all new objects placed on the form will be 
visible and will print.

With this toggled Off (no check mark), all new objects added will default to non-printable.

With this option, an entire form could be designed for screen display only, where no objects 
would print. However, you could then add fill-out only fields after turning the Printable attribute 
back ON. Then, text and fields or objects subsequently added will print when the form is printed.
That is, ONLY the objects added after the Printable attribute is turned on, will print. This is how 
you would set up your form for printing data to pre-printed forms. This is also know as CFO 
(clear forms overlay.)

Caution:  When you do set Options-Defaults-Printable off, be sure to reset the form design 
attribute before continuing with the background form design. Otherwise, the remainder of the 
form will be visible during the rest of the design stage, but will not print.



Printable command (Options-Defaults menu)

With this option toggled On (check mark visible) all objects placed on the form will be visible and
will print. All options are saved into the .INI file with the Options-Save Settings command.

With this toggled Off (no check mark), all new objects added will default to non-printable. 
Existing objects are unaffected. With this option, an entire form could be designed for screen 
display only. Nothing will print.

However, you could then add fill-out only fields after turning the Printable attribute back ON. 
Then, text and fields or objects subsequently added will print when the form is printed. That is, 
ONLY the objects added after the Printable attribute is turned on, will print. 

This is how you would set up your form for printing data to pre-printed forms. This is also know 
as CFO (clear forms overlay.)

Caution:  If you do set an Options-Defaults-Printable to be non-printable be sure to reset the 
form design attribute before continuing with the background form design. Otherwise, the 
remainder of the form will be visible during the rest of the design stage, but will not print. 
Instead, to change the printable attribute of one object, place the object then use the Form 
Printable command described below.

Form-Printable

Any object placed on the form can either be Printable (visible on screen as well as paper 
printouts) or Non-Printable (visible only on-screen and not printed).

Selecting this command will toggle on or off the printable attribute for that particular text, field, or
other object. You can also access this command with the object popup menu.

You can also use this feature to insert special instructions or notations in your form that will 
never be printed.

HINT: Each object can be set to printable or non-printable at any time with the Form-Printable 
command.



Process Dialog

During fillout, field validations and calculations are carried out as appropriate, whenever the 
cursor moves into or out of a field. Since EZ-Forms provides various methods for changing field 
order and even bypassing fields, validations and calculations are repeated for all fields just prior 
to committing a form to use, such as when saving or printing it. However, there are situations 
where this repetition may not be appropriate, such as when saving a blank form.

This dialog allows for complete control over when revalidation and recalculation occur for all 
fields. When none of the fields make use of one or the other, that option is disabled. When the 
automatic processing is useful, or even when you're not sure, simply leave the options turned 
on. Otherwise, depending on the situation, you can turn revalidation or recalculation off.

At any time, use the Field Recalc All command to revalidate and recalculate all fields. This is 
identical to the processing described above. Fields are evaluated in normal left-right, top-down 
order.



Are you sure you want to clear the entire form?
Design mode

All objects in the form will be deleted.

Fillout mode

All fields will be cleared, and the master form will remain intact. When modifying an existing 
filled-out-form(.FOF), fields are only cleared in memory, leaving the file unchanged.

To prepare a new form to fill out, use the Edit-Fillout-New command.



Save option settings?
If you have modified any of the default settings in the Options menu, this message is a reminder
at program exit to save those changes. All defaults are saved in the (program).INI file in your 
Windows subdirectory.



RTRIM(char)
Description Removes all blanks at the end (right side) of a character string.

Syntax RTRIM(char)

char is any text string.

See Also LTRIM function

Examples RTRIM("          ") returns "" (empty character string)

RTRIM("      Corporation            ") returns "      Corporation"



Rectangle command (Draw menu)

Rectangle Drawing tool. Activate by clicking on the Rectangle Toolbar button or by selecting the 
Draw-Rectangle command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a rectangle 
to the desired size.
3) Release the mouse button when done.

When the Snap-to-Grid option is selected in the Grid dialog box, the rectangle's corner points 
will "snap" to the nearest grid points.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Refresh command (View menu)

Use Refresh to update the screen at any time. This may be necessary when artifacts are 
caused by the Windows GUI or some video drivers during busy or complex editing sessions.

Shortcut
Keys: Ctrl + R



This number indicates the number of days between automatic reminders of probable EZ-Forms 
upgrades. The reminder message will reappear every 7-180 days (you select) in order to remind
you that it may be time to get the latest version of EZ-Forms. This is not meant to nag you, but 
to gently remind you that we may have bigger and better things in the works.



Restore command (Control menu)

Use this command to return the active window to its previous size and position, before you 
selected the Maximize or Minimize command.



RoundRect command (Draw menu)

Rounded Rectangle Drawing tool. Activate by clicking on the Rounded Rectangle Toolbar 
button, or by selecting the Draw-RoundRect command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a rounded 
rectangle to the desired size.
3) Release the mouse button when done.

When the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's 
corner points will "snap" to the nearest grid points.

Note
At the top right of the highlighted object there is a tab on the inside corner used to adjust the 
corner arch or roundness of all four corners.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



SIN(num)
Description Returns the sine of the supplied angle.

Syntax SIN(number)

number is the angle in radians. If the angle is in degrees, convert the angle to radians first by 
multiplying the angle by PI()/180.

See Also ASIN and PI functions

Examples SIN(1.4) returns .985

SIN(90 * (PI()/180)) returns 1



SINH(num)
Description Returns the hyperbolic sine of the specified number.

Syntax SINH(number)

number is the angle in radians. If the angle is in degrees, convert the angle to radians first by 
multiplying the angle by PI()/180.

See Also PI function

Examples SINH(1) returns 1.18

SINH(3) returns 10.02



SQRT(num)
Description Returns the square root of the specified number. 

Syntax SQRT(num)

num is any positive number. If you specify a negative number, an error will result.

Examples SQRT(9) returns 3

SQRT(2.5) returns 1.58



STOD(char)
Description Converts String to Date.

Syntax STOD(char)

char is a character string representing a format-independant date. The format is "CCYYMMDD".

Remarks The String to Date function converts a character value date string into a date 
value.

See Also DTOS, CTOD, DATE and DTOC functions

Example STOD("19951219") returns the date value of December 19, 1995.



STR(num,num,num)
Description Converts Numeric value to a Character value

Syntax STR(num, width, decimals)

num can be any valid numeric value.
width can only be an integer value between 1 and 37.
decimals can only be an integer value between 0 and 15.

Remarks Converts num into a character value. width is the number of characters in the 
new string, including the decimal point. decimals is the number of decimal 
places desired. This functions provides capabilities similar to the options in 
the Form Field Setup Options dialog for numeric type fields.

Examples STR(35.2, 5, 2) returns "35.20"    The number 35.2 is converted to a string of 
length 5, where 2 of the 5 are decimal places.

STR(3.9, 3, 2) returns "***"    The number 3.9 cannot fit into a string of length 
3, if it is to have 2 decimal places. Consequently, "*"s are filled in.



SUBSTR(char,num,num)
Description Returns a portion of the original string

Syntax SUBSTR(char_value, start_position, num_chars)

char_value is any valid character value text string.
start_position is an integer value.
num_chars is an integer value.

Remarks The Substring function will return a substring (portion) of char_value. The 
substring will be num_chars long, and will start at the start_position character 
of char_value.

See Also INSTR function

Examples SUBSTR("ABCDE", 2, 3) returns "BCD"

SUBSTR("Mrs. Jones", 3, 1) returns "s"



Save command (File menu)

Use this command to save the active form to its current name and directory. When you save a 
form for the first time, EZ-Forms displays the Save As dialog box so you can name your form. If 
you want to change the name and directory of an existing form before you save it, choose the 
Save As command. This command and its corresponding toolbar button will be greyed-out until 
the form has been modified.

Shortcut
Toolbar:
Keys: Ctrl + S



Save All command (File menu)

This command is used when there are two or more form windows open, one or more of which 
have been modified. Saves all open form files so you do not have to step through the save 
procedure for each and every one of them.



Save As command (File menu)

Use this command to save and name or rename the active form. EZ-Forms displays the Save 
As dialog box so you can name your form.

To save a form with its existing name and directory, use the Save command.

Note: The single user, non-network version of EZ-Forms will not read-from or save-to a network
drive.



File Save As Dialog

The following options allow you to specify the name and location of the file you're about to save:

File Name:
Type a new filename to save a form with a different name. A filename can contain up to eight 
characters followed by a period and then an extension of up to three characters. EZ-Forms adds
the extension. You specify the file name in the Save File As Type box. Notice that the file listing 
is shaded to help prevent using a file name that is already used. This area of the dialog box 
shows a shaded listing of files in the current subdirectory. The listing may help in naming the 
new file if you've forgotten the filenames already used. You can indicate the type of files you 
want listed by clicking on the arrow in the section just below.

Directories:
This section indicates the current subdirectory. Use the section below to change to a different 
subdirectory. Change subdirectories by using the scroll bar or by double-clicking on a directory 
name. If a directory is not shown, it may be located as a subdirectory below the one just above 
the current subdirectory. Try double-clicking on a directory name that is one or two levels above 
the current subdirectory.

Save File as Type:
Click on the arrow to change the type of files listed in the section just above.
Available choices are:
Master Forms. (*.frm)
All Files (*.*)

Drives:
Click on the arrow to search for files on a different drive.

Network button
If you are connected to a network file server or workgroup, this button will activate your available
network services.
Note:    The single user version does not support network drive or services access even though 
the Network button may be active.



Save Settings (Options menu)

Your fine tuning of the Defaults and Preferences settings will remain effective only during the 
current session. If you want them to apply to future sessions, they must be saved. Temporary 
adjustments for the current EZ-Forms session may be made to the options settings for repetitive
or similar tasks without the need to make those settings permanent. Individual objects can be 
modified using the Form pulldown menu or the object popup menu. You must decide whether or 
not you will need the new adjustments after you have ended this session.

See Also

Modifying Object Attributes



Fixed Views (View menu)

View scales allow for "zoom" in or out of any part of a form. "Scaling" or "zoom" is very similar to
how a zoom lens works on a camera. Zoom in and see it larger and in more detail, but see less 
of the form. Zoom out and see more of the form at a time, but see it smaller and in less detail. 
Depending on your screen resolution, a different scaling will be needed in order to view the 
entire form. If none of the standard scales match your needs, there are two user-definable 
scales. Print preview also allows for zooming in and out, but design and fillout features are 
unavailable there.

Four standard viewing scales are selectable from the View menu and three of the most common
ones are available on the Toolbar. Two additional custom scales are user-definable in the 
Options-Preferences dialog box and are displayed only in the View menu.

Shortcut
Toolbar:

Custom Views (View menu)

The two custom views can be adjusted to your preference. In the Options-Preferences dialog 
box there are two fields where you define the view scale settings. Acceptable values are 25% 
through 300%.



Scanner - Acquire (File menu)

This command is only available when a scanner is connected to your system and a TWAIN-
compatible Windows driver is installed.

File Scanner Acquire will initiate the scanning control module of your TWAIN-compatible 
scanner driver software. Once this is done, EZ-Forms waits patiently in the background while 
you perform the scanning. Details regarding the scanning process will vary depending on 
scanner manufacturer. Typically drivers provide a preview mode where the scanned image can 
be proofed and rescanned prior to committing it to use. The final step is to exit the scanner 
module when scanning is complete. EZ-Forms will then automatically resume and ask whether 
the object is to be inserted as embedded or linked. If linked is chosen, the image must first be 
saved to a separate file. See Edit Insert Graphic for more information regarding embedded and 
linked images.

Be aware that printing a full page scan will greatly increase the amount of time required to print 
the form. Designing a form with line, text, field, small images and drawing graphic objects will 
decrease print time and improve the appearance of your final output. Generally, you should use 
the full page scanned images to setup your form for use with pre-printed forms. Design from 
scratch those that need to have a crisp professional appearance.

To Print only the data entered into full page scanned form (for use with pre-printed forms), turn 
OFF the image's Printable attribute. You do this by highlighting the image and make sure there 
is no check mark in front of pull down menu selection Form-Printable. Leave field objects as 
Printable.

See Also

File Scanner Select Source
Your scanner documentation



Scanner - Select Source (File menu)

Before using the File Scanner Acquire command, it may be necessary to select a TWAIN-
compliant device with this command. When there are multiple scanners available on your 
system, Select Source allows you to choose which one will be invoked.

See Also

File Scanner Acquire
Your scanner documentation



Select command (Draw menu)

Activate select mode. Click on the Select Toolbar button, or choose either the Edit-Select or 
Draw-Select commands. Once in select mode, an object is selected by placing the mouse 
cursor anywhere on the object and clicking the left mouse button. A selected object can be cut, 
copied, moved, resized or have its attributes modified.

Shortcut
Toolbar:



Select command (Edit menu)

When designing a master form, the Select command activates select mode. Click on the Select 
Toolbar button, or use either the Edit-Select or Draw-Select commands. Once in select mode, 
an object is selected by placing the mouse cursor anywhere on the object and clicking the left 
mouse button. A selected object can be cut, copied, moved, resized or have its attributes 
modified.

Shortcut
Toolbar:



Select All (Edit menu)

Selects all objects in the form. This is a quicker alternative to selecting each object individually.

Selecting all objects may be done in preparation for moving, copying, etc.



Troubleshooting: Selecting colors through “Text & Field 
Edit Background Color”
Problem: Color are light-grey after selecting a change.

Solution: Select a bright color than the one you just chose. The available colors for display 
depend on the capabilities of both your monitor and video card as well as the current color 
depth setting. A color depth of 256 will not display all of the color choices available in the Color 
dialog. Increasing the display setting to 64K or 16 million display colors will improve the 
available choices allowed. 



Send Mail (File menu)

Send a message via the resident email system, and sends the current form as an attachment. 
This is the same as if you were to send a message using your email program directly.

This menu item will not appear unless you have an email system that supports the Microsoft 
MAPI standard.



Size command (Control menu)

Click on the upper left corner (control tab) of the form window and select size.

Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 

pointer to the border you want to move.
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the 

window.



Status Bar

The status bar is displayed at the bottom of the EZ-Forms window. To display or hide the status 
bar, use the Status Bar command in the View menu.

The left area of the status bar (also know as micro-Help) describes menu items as you use the 
arrow keys to navigate through menus.

This area similarly shows “fly-by” messages that describe the toolbar buttons as the cursor 
passes over them.

To the right of the message area is an indicator telling you the current page number of the active
form.

Further to the right, two numeric values are displayed, representing the horizontal and vertical 
mouse position on the form relative to the upper-left corner of the drawing area. 

Another indicator will display "Master", or "Fillout" depending on the function mode you are in.

The far right area of the status bar indicates which of the following keys are set (check your 
keyboard for a light or other indication):

CAP The Caps Lock key is set.
NUM The Num Lock key is set.



Switch To command (Application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or 
close an application on the list.

Shortcut
Keys: Ctrl + Esc

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:

Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.

Cancel
Closes the Task List box.

Cascade
Arranges open applications so they overlap and you can see each title bar. This option does not
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap. This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



TAN(num)
Description Returns the tangent of the specified angle. 

Syntax TAN(number)

number is the angle in radians. If the angle is in degrees, convert the angle to radians first by 
multiplying the angle by PI()/180.

See Also ATAN, ATAN2, PI, and TANH functions

Examples TAN(.785) returns 1

TAN(135 * (PI()/180)) returns -1



TANH(num)
Description Returns the hyperbolic tangent of a number.

Syntax TANH(number)

number is the angle in radians. If the angle is in degrees, convert the angle to radians first by 
multiplying the angle by PI()/180.

See Also COSH, SINH, and TAN functions

Examples TANH(-2) returns -.96

TANH(1.2) returns .83



TIME()
Description Returns the current time as a character value text string.

Syntax TIME()

Remarks This function is updated only when the form is recalculated.

See Also DATE function



Test OK. The expression has a Logical type result.
Design mode

When testing a validate expression during form design, this message confirms that the 
expression is valid for its intended purpose.

To pass validation during fillout, the expression must evaluate to TRUE.

See Also

Expressions



Test OK. The expression result is of type: ??.
Design mode

When testing a calculation during form design, this message confirms that the result 
type of the expression matches the type of the field.



"TestDrive" refers to a fully functional version of EZ-Forms that is meant for evaluation of same, 
much like you test drive an automobile before you purchase it. Also, just like a test drive, the 
salesman usually comes along. So you may have to put up with occasional “commercials” 
asking you to purchase (a.k.a. regi$ter) the program.

The TestDrive edition of EZ-Forms is functionally identical to the full or registered version. 
However, only two forms may be opened simultaneously.

Regi$tering removes all TestDrive screens. Please feel free to “share” TestDrive editions ONLY 
of EZ-Forms with your associates.

Please help us keep the cost of software low by NOT SHARING registered versions of EZ-
Forms with anyone within the limits of the license granted to legitimate purchasers by EZX.



TestDrive Enhancement disabled a few features of the TestDrive version of the program and is 
time limited. Enhancement will remove the advertisement popup during operation. The popup 
will still be there when you first start the program and when you exit the program. Enhancement 
will also remove the floating water-mark for any print jobs and will allow more that two forms to 
be open at a time.

If you would like to enhance your testdrive experience with EZ-Forms contact us at 
1•281•280•9900 with the program running and no forms loaded. Select the pull down menu 
Options-Enhance and a dialog box will appear. About in the middle is a User ID Code. We will 
need that code to generate an encrypted sequence of letters and numbers. The encrypted 
sequence is what you will enter in the “Enhamcement Code:” entry section.

The sequence we give you will consist of sixteen letters and numbers. All letters are capitalized. 
The sequence does not use the character “O”, we use the numeric zero instead. Generally we 
will give you four of the sixteen at a time, and there are no spaces between any letters of 
numbers. Enter the encypted sequence in the space provided and click over the “Enhance” 
button. A small dialog will appear indicating the length of time the ehnacement is set for.

If the entry is not accepted by the program it is usually due to a typo. You will need to select 
Options-Enhance a second time, which will generate a different User ID Code. A different 
encrypted Enhancement Code sequence will then be give for you to enter into the dialog box.

Moving the program files to a different subdirectory or drive will disable the enhancement code. 
Be sure to keep the program where it is after receiving the enhancement.



Text command (Draw menu)

Text Drawing tool. Activate by clicking on the Text Toolbar button, or by selecting the Draw-Text 
command.

1) Position the mouse pointer to where you want to begin drawing.
2) Press and hold the left mouse button while dragging the mouse, thereby drawing a rectangle 
to the desired size of the text area.
3) Release the mouse button when done.

Height of the text area is fixed to a multiple of the selected font height. When changing a font, 
be sure to also readjust the height of the text area.

When the Snap-to-Grid option is selected in the Grid dialog box, the encompassing rectangle's 
corner points will "snap" to the nearest grid points.

Once created, a text cursor will flash in the object on the form to indicate that text can now be 
entered. When done, the Enter key will end text entry.

To modify it after initial entry, double-click on the text.

See Also

Modifying Object Attributes and Moving and Resizing Objects

Shortcut
Toolbar:



Text command (Edit menu)

When a single text object is selected, this command will re-enter edit mode on that text. This is 
similar to what happens when a text object is created. In either case, when done editing the text,
press the Enter key or click on another object to finish editing.

Shortcut
Mouse: Double-click on 

text object



Text command (Form menu)

Modify text attributes for the selected object by using the Text command in the Form menu or 
the object popup menu.

See Also

Text dialog box
Font dialog box



Text command (Options-Defaults menu)

The settings assigned in the Options-Defaults-Text dialog box are used to set defaults for all 
newly created text and field objects. Existing objects are unaffected.

All options are saved into the .INI file with the Options-Save Settings command.



Text Dialog

Choose justification, margins, etc., for Text and Field objects. When accessed with the Options-
Defaults-Text menu, text selections will only affect newly created objects.

The text characteristics of any Text or Field object can be altered after placement by using the 
Form Text command, accessible from the main menu or the object popup menu. The dialog box 
title will not include "Defaults" when modifying an existing object.

Hint:  Double-click on an existing Text object to quickly change to text edit mode.

Justification:
Set the properties for any given text or field object to the Left, Center, or Right side of that area. 
Also, Full Justification will extend the text from left edge to right edge by adding proportional 
spacing between each word of the text or field object. Settings here are used for both Text areas
and Field objects.

Margins:
Use this section to adjust margin settings within Text and Field objects. Fine adjustments and 
character alignment are possible with this method.

Border:
Add a border around the Text or Field object.

Text Color button
Access the Color dialog box to choose from a given color set.



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Text Feed-Time (Edit menu) & Time (Field menu)

Quickly insert system Time into a field during data entry using Ctrl + T. Any text that may 
already be in the field will be overwritten. You will not be able to auto insert into the middle of a 
sentence or phrase.

The format for Auto Text Feed is controlled by the Windows Control Panel International settings.

Shortcut
Toolbar:
 Keys: Ctrl + T



Tip of the Day

A series of operating tips and suggestions are displayed to help remind and inform you of things
that may help in certain situations. Step through each of the tips using the Next Tip button at the
bottom center of the dialog.

Each time EZ-Forms is loaded the next tip in the series is displayed as a helpful daily reminder. 
You may review the series of tips at any time by selecting from the Help pulldown menu “Tip of 
the Day”.

Though the display generally appears each time EZ-Forms is loaded, you may disable this 
action by clicking over the toggle at the bottom left with statement “Show Tips at Startup”



To Back command (Form menu)

Use the To Back command when two or more objects overlap each other. If the one you want 
fully displayed is positioned under another, highlight the top object and use this command to 
place it behind all others.

Fields are treated differently than other objects when considering object overlap, therefore the 
To Front and To Back commands are unavailable for field objects.



To Front command (Form menu)

Use the To Front command when two or more objects overlap each other. If the one you want 
fully displayed is partially visible behind another object, highlight the partially hidden object and 
use this command to place it on top of the others.

Fields are treated differently than other objects when considering object overlap, therefore the 
To Front and To Back commands are unavailable for field objects.



Main Toolbar

The main toolbar is displayed across the top of the EZ-Forms main window, below the menu 
bar. It provides quick mouse access to the commands used most often. To hide or display the 
Main Toolbar, select the Toolbar option from the Options Preferences Main dialog tab.

Toolbar - Design Mode
Displayed across the top of the active form's window while in design mode only. It provides 
quick mouse access to various commands that are unique to design mode.

Toolbar - Fillout Mode
Displayed across the top of the active form's window while in fillout mode only. It provides quick 
mouse access to various commands that are unique to fillout mode.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

File - New Ctrl + N
Create a new form. EZ-Forms displays the Form Layout dialog box to select various form 
attributes.

File - Open Ctrl + O
Open an existing form. EZ-Forms displays the Open dialog box, in which you can locate and 
open the desired file.

File - Save Ctrl + S
Save the active form or template with its current name. If you have not named the form, EZ-
Forms displays the Save As dialog box.

Edit - Cut Ctrl + X
Selected objects or text can be removed by using the Cut toolbar button or the Edit-Cut 
command. The object or text is also placed in temporary storage on the Windows clipboard.

Edit - Copy Ctrl + C
Make a duplicate copy of the selection to the clipboard. Selected objects can be duplicated by 
using the Copy toolbar button or the Edit-Copy command.

Edit - Paste Ctrl + V
Insert the contents of the clipboard into the active form. For text, position the cursor to the 
desired place before pasting. Objects and text can be pasted by using the Paste toolbar button 
or the Edit-Paste command.



File - Print Preview Preview the active form on screen. Click on this toolbar button or 
select the File-Print Preview command.

File - Print Ctrl + P
Presents a Print dialog box, where you may specify number of copies, destination printer, and 
other printer setup options.

Help - Contents F1
Displays the EZ-Forms Help Contents screen.

Context Help Shift + F1
Use the Context Help command to obtain help on a specific EZ-Forms command, icon or 
screen area.

View - Scale Three of the six most commonly used view choices.

View - Go To Page
Previous With a multi-page form loaded, and the current page number 

of the form is greater than one, selecting the Got To Page - 
Previous option from the View pulldown menu will change the 
display and focus to the preceding page in the sequence of the
active form.

View - Go To Page
Next With a multi-page form loaded, and the current page number 

of the form is not the last page of the form, selecting the Got 
To Page - Next option from the View pulldown menu will 
change the display and focus to the next page in the sequence
of the active form.



Design Mode Toolbar
Displayed across the top of the active form's window while in design mode only. It provides 
quick mouse access to various commands that are unique to design mode. To hide or display 
this toolbar, select the Toolbar option from the Options Preferences Master dialog tab.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

Edit / Draw - Select Click on the Select Toolbar button, or use the Edit-Select or Draw-
Select commands.

Draw - Line Line Drawing tool.

Draw - Rectangle Rectangle Drawing tool.

Draw - RoundRect Rounded Rectangle Drawing tool.

Draw - Ellipse Ellipse Drawing tool.

Draw - Text Text Drawing tool.

Draw - Field Field Drawing tool.



Fillout Mode Toolbar

Displayed across the top of the active form's window while in fillout mode only. It provides quick 
mouse access to various commands that are unique to fillout mode. To hide or display this 
toolbar, select the Toolbar option from the Options Preferences Fillout dialog tab.

Click on any toolbar button for further explanation.

Toolbar:    Pulldown Menu: Hot Key:
Action:

Field - Help Ctrl + H
Display a field-specific Help screen created by the form designer.

Field - Pick Ctrl + L
Display field-specific Pick list created by the form designer.

Field - Date Ctrl + D
Place the current date into the field.

Field - Time Ctrl + T
Place the current time into the field.

Field - Validate Validate this field's contents based on the form designer's criteria.

Field - Calculate Recalculate the formula in the current field.



Troubleshooting
General Protection Fault Errors

Inserting OLE Objects

Graphic Image (.BMP, .PCX, MSP) shows as Icon.

Can't find auto number, pick list, field help file or tip file

Selecting colors through “Text & Field Edit Background Color”

Divide by Zero Error



Troubleshooting: Can't find auto number, pick list or field 
help file
Problem: During fillout or design mode field setup test, EZ-Forms can't find auto number, pick 
list or field help files.

Solution: When EZ-Forms needs an auto number, pick list or field help file, where it looks for it 
depends on whether the form designer specified the full path to it or just the file name. There 
are tradeoffs to both situations, so the final solution depends on your particular needs.

When a file is specified by file name only, EZ-Forms looks in the same directory as the form file 
itself. This can create problems when copying or saving filled-out forms into directories other 
than the original. In this case, make sure to copy all associated files with the form. This method 
is desirable when form files tend to move between different systems or are shared on a LAN.

When a file is specified by it's full path name, EZ-Forms always uses that path when looking for 
the file. This can resolve the situation of saving fillout forms into directories other than the 
original of the same system. It may not help when moving forms to different computers or 
systems. Use this method only for form files that are not generally moved around between 
directories and systems.

The file containing the “Tip of the Day” displayed when EZ-Forms is first load and by selecting 
Help-Tip of the Day has the same name as the executable program except with a .tip extension.
This file must be located in the same directory location as the program file in order for the 
program to access it.

If EZ-Forms does not seem to access one or more of these files while there are several forms 
loaded or when several other programs are open, try closing some of the forms or programs 
and try again. It may be possible that you are running low of either memory (physical, virtual or 
both) or system resources.



Troubleshooting: General Protection Fault Errors
Problem: You receive an error message indicating that EZ-Forms has caused a General 
Protection Fault (GPF) Windows system error.

Solution: GPFs are very tricky things. Usually they happen when resources are low (has 
nothing to do with memory installed), or possibly some other unstable program is running or has
been shut down and it has left open some files or other system resources.

If you are using Windwos 3.1, your CONFIG.SYS file should contain the following statements:
      FILES=80
      stacks=16,512
      SHELL=C:\DOS\COMMAND.COM C:\DOS\ /e:1024 /p    (do not change if already set.)
      DOS=HIGH    or DOS=UMB      (do not change if already set.)

The 'SHELL=' path may need to be changed for your system.

It is possible that GPFs could be caused by running out of room on the system stack heap. 
Increasing the files count and stack resources will probably solve the failure. See the DOS 
documentation for the STACK command for more information. Try running EZ-Forms as the only
open program in Windows. Check the Startup group for any programs that load automatically.



Troubleshooting: Graphic Image Shows As Icon
Problem: When using OLE, graphic images are represented by a graphic program icon.

Cause-1: There is not enough physical RAM installed in your computer.
Solution-1: Increase the amount of RAM (memory chips) in your computer. Virtual RAM 
(swapping to disk) is not used for OLE functions. Importing a small BMP image probably works 
fine with your current memory. Importing a full page scanned image requires much more 
memory to function properly.

Cause-2: Another program has improperly modified the OLE registration data file.
Solution-2: Print this Help Topic if necessary and follow the sequence below.

Note: This procedure assumes that you are using the Windows Paintbrush program to support 
graphic images. If you are using a different program, substitute the appropriate names below.

1. With the Program Manager File-Run command, select the file named REGEDIT.EXE 
located in the Windows subdirectory and add to the command line a space, forward slash and 
the letter " V ". Click the OK button.
[    REGEDIT.EXE /V    ]

2. In REGEDIT, press the Home key to position the cursor at top of data.

3. Maximize the program window by clicking on the Top-Right corner arrow of the program 
window, then select the Edit-Add key command.

4. A dialog popup requires entry of the following. Be sure you start the Key: entry with a 
period as an indicator of a specific file extension.

Key: .BMP

Value: PBRUSH

5. Press the Home key to position the cursor at top of data again.

Repeat the process from step # 3 to add the following two file extensions to the list.

Key: .PCX

Value: PBRUSH

The final addition to the data structure should look like this.
Be sure to press the Home key before adding.

Key: .MSP

Value: PBRUSH



After the three file extensions have been added to the top of the data structure, select File-Save 
Changes. Exit the program and restart Windows.

Check that the changes did correct the BMP to Icon Link by first starting EZ-Forms. Open a 
New form. Insert an Object with a .BMP file extension. Check that the .BMP image shows as it 
is, not as a "Paint" icon.



Troubleshooting: Inserting OLE Objects
Problem: Unable to successfully place graphic images on a form.

Solution: OLE objects can be inserted into a master form by using the Edit-Insert New Object 
command. Object Linking and Embedding (OLE) means that an object (data or file) can be 
embedded or linked to another application that doesn't directly support the object format. The 
application that does support the object format is called the OLE server. The application that 
can embed or link to OLE objects is called an OLE client or OLE container. EZ-Forms is an 
OLE container application.

Linking requires a file, which can reside in any subdirectory on any disk drive. When the file is 
changed by the OLE server application, EZ-Forms can be set to update the link either manually 
or automatically. An automatic link is immediately updated in EZ-Forms. Updating a manual link 
requires use of the Edit Links command. Each type of link serves a different purpose, to be 
determined at master form design time. When using a manual link, the object's data is stored 
directly into the form, along with the original file name. With an automatic link, only the object's 
file name is stored into the form.

Embedding does not require a file. An object can be created at insertion time, or loaded from an 
existing file. The embedded object becomes part of the master form file, and the data can only 
be changed through EZ-Forms, via the OLE server application.

Image files, sound files, and video files are examples of objects that can be embedded into a 
EZ-Forms form by using the Edit-Insert New Object command.

There are several example files containing a selection of images that you may find useful. The 
images stored in filenames IMAGE*.FRM (or .FOF) can be transferred from the original file to a 
form you are designing with copy (Ctrl + C) and paste (Ctrl + V).



UPPER(char)
Description Changes the characters in the specified string to uppercase characters. 

Syntax UPPER(text)

text is any character value text string.

Remarks Numeric characters in the string are not changed.

See Also LOWER and PROPER functions

Examples UPPER("3rd Quarter") returns "3RD QUARTER"

UPPER("jOhN doE") returns "JOHN DOE"



Undo Delete Command (Edit menu)

Use this command to reverse the last delete, if possible.

Shortcut
Keys: Ctrl + Z      or

Alt + Backspace



Using EZ-Forms with Microsoft Word, Microsoft Excel, and
any other OLE enabled program. (and visa-versa)
FYI:    OLE is an acronym for Object Linking and Embedding. In short, OLE allows an object 
created by an OLE server (such as Paint, Excel, Word, etc.) to be embedded into an OLE client 
application, in this case EZ-Forms. This very powerful feature allows placement of graphics, 
sound, video or other objects onto a EZ-Forms form. It also allows you to place EZ-Forms files 
(or objects) into OLE client/server applications like the above.

Lets say you are using Microsoft Word**, and would like to "embed" an EZ-Form on page 4 of 
your document. No problem. Simply open your document and place your cursor where you want
you EZ-Forms to be. Then click on    "Insert Object" (it may be Edit-Insert-Object). Then select 
"Create From File". Do not check any other box. Browse for your EZ-Form (usually a .FOF 
or .FOM extension) and click OK. After the hourglass goes away, you will see the EZ-Forms 
icon (a form with a lightning bolt thru it) along with the name of the form below it. Save your 
work at this point. Whenever you double-click on this icon, EZ-Forms will be launched along 
with the form that it is linked to via this OLE association.

**Note: While MS Word, Excel, etc. are great programs, in our opinion, they do not do "forms" 
very well, hence the need for a real "forms processor" like EZ-Forms.

The above method will work with any Windows software that is OLE client (or container) 
capable.

ON THE OTHER HAND ...    (visa-versa)
You can ALSO embed any other OLE server's objects into EZ-Forms.
OLE objects can be inserted into a master form by using the Edit-Insert New Object command. 
Object Linking and Embedding (OLE) means that an object (data or file) can be embedded or 
linked to another application that doesn't directly support the object format. The application that 
does support the object format is called the OLE server. The application that can embed or link 
to OLE objects is called an OLE client or OLE container. EZ-Forms is an OLE container 
application.

Linking requires a file, which can reside in any subdirectory on any disk drive. When the file is 
changed by the OLE server application, EZ-Forms can be set to update the link either manually 
or automatically. An automatic link is immediately updated in EZ-Forms. Updating a manual link 
requires use of the Edit Links command. Each type of link serves a different purpose, to be 
determined at master form design time. When using a manual link, the object's data is stored 
directly into the form, along with the original file name. With an automatic link, only the object's 
file name is stored into the form.

Embedding does not require a file. An object can be created at insertion time, or loaded from an 
existing file. The embedded object becomes part of the master form file, and the data can only 
be changed through EZ-Forms, via the OLE server application.

Image files, sound files, and video files are examples of objects that can be embedded into a 
EZ-Forms form by using the Edit-Insert New Object command.

There are several example files containing a selection of images that you may find useful. The 



images stored in filenames IMAGE*.FRM (or .FOF) can be transferred from the original file to a 
form you are designing with copy (Ctrl + C) and paste (Ctrl + V).



Using Help command (Help menu)

Use this command for detailed instructions about how to use the Windows Help program.



VAL(char)
Description Returns the specified text as a number.

Syntax VAL(char)

char is any character value text string that represents a valid number.

See Also Constants

Examples VAL("13") returns 13

VAL("-100023.45") returns -100023.45

VAL("Fred") returns 0.



Validate command (Field menu)

When a validation exists for the current field, this command will process it. A field validation is 
created by the form designer in order to make form fillout easier and more accurate. Unless 
"override on error' was selected by the designer, fillout cannot continue to the next field until 
valid data is placed into the field.

When a field does contain invalid data, an error message displays. This error message could 
have been written by the designer, but if it wasn't it defaults to a generic one. Since validations 
are written as expressions like calculation are, expression errors can also occur. Any errors will 
result in an error message displaying the expression and the field name of occurrence. It is 
important to distinguish between validation errors and expression errors. Typically expression 
errors will require resolution by the form designer. A validation error is simply a false result from 
a validation expression, and is resolved by the form filler.

Shortcut
Toolbar:



We are constantly striving to improve the operation, versatility and user productivity of EZ-
Forms for Windows. You may be interested in the latest program enhancements. You may also 
wish to license multiple copies and/or a Local Area Network version.

Call EZX/SSW at +1.281.280.9900 (FAX: +1.281.280.0099) for information concerning new 
features, benefits, etc.. Be sure the registration card has been properly filled out and mailed in 
to us. As a courtesy to registered users we offer special upgrade pricing on all versions of EZ-
Forms.

If you have a registered version of EZ-Forms, be sure the registration card has been properly 
filled out and mailed in to us.

EZX Corp., PO Box 58177, Webster, TX 77598-8177 USA

Special versions of EZ-Forms (using the EZ-Forms PRO Filler engine) specifically tied to 
custom developed forms, are the “engines” that drive products like ExportPower PRO™, 
WinDD250 PRO™, FormTrooper™, EZ-MSDS™, PackageTrakker™, YourForms PRO™, 
WinSF171™, AnyPower™, MedTrakker™, ExpenseTrakker™, etc. Call for details.

Should you require a special re-distributeable edition of EZ-Forms XL, it is known as EZ-Forms 
PRO and is available in Site, Corporate, and Developer's editions.

* Call for Multi-user, LAN, Server, Site,
    Corporate and Developer's licensing and
    extended support. (EZ-Forms PRO)



A reminder for EZ-Forms TestDrive edition users that the program was developed at least one 
year ago. Certain features may now be completely disabled, but none of your forms will ever be 
lost. You just will not be able to save any new changes. THIS VERSION OF EZ-Forms HAS 
EXPIRED!

Call for latest information concerning product version, pricing and added features. We accept 
Visa, MasterCard, Discover and American Express via the phone.

We are constantly striving to improve the operation, versatility and user productivity of EZ-
Forms for Windows. You may be interested in the latest program enhancements. You may also 
wish to license multiple copies and/or a Local Area Network versions.

Call EZX/SSW at +1.281.280.9900 (FAX: +1.281.280.0099) for information concerning new 
features, benefits, etc.

If you have a registered version of EZ-Forms, be sure the registration card has been properly 
filled out and mailed in to us.
EZX Corp., PO Box 58177, Webster, TX 77598-8177 USA

Special versions of EZ-Forms (using the EZ-Forms PRO Filler engine) specifically tied to 
custom developed forms, are the “engines” that drive products like ExportPower PRO™, 
WinDD250 PRO™, FormTrooper™, EZ-MSDS™, PackageTrakker™, YourForms PRO™, 
WinSF171™, AnyPower™, MedTrakker™, ExpenseTrakker™, etc. Call for details.

Should you require a special re-distributeable edition of EZ-Forms XL, it is known as EZ-Forms 
PRO and is available in Site, Corporate, and Developer's editions.

* Call for Multi-user, LAN, Server, Site,
    Corporate and Developer's licensing and
    extended support. (EZ-Forms PRO)



The form orientation does not match the printer orientation
setting. Continue printing?
A form's orientation is chosen by the designer with the Form Layout command. The File Print 
Setup command allows setting of various print options, among them is orientation. When these 
orientations don't match exactly, this message results. It is possible to continue printing, but the 
resulting printout will probably be unusable.

Other problems can result when the paper size used in the printer does not match the size 
specified for the form. However these problems are less likely and probably more obvious.



Save this form before continuing.
Design mode

Changes are about to be made to the form in memory, so the current form must be saved. 

Fillout mode reads in the form in a specific manner to provide access to field data entry areas 
only. When completed, the form in the active window (memory) is saved to a separate file with a
.FOF file extension. With this method the master form is not modified and is available for future 
entries containing different data that may be saved to a different .FOF file.

Once saved, data entry fields in .FOF files may be modified at any time. This method may be 
used to clone new filled-out forms that may contain repetitive data.

Remedy

Save the form, then reselect the command.



What is an Eform?
So, what is an Eform????
"Simply it is the on-sceen, computerized manifestation of a form that is typically filled out on a 
piece of paper. Since filling the form is done within a computer program, many features 
unavailble with a typewriter or pen are available, including: Background/image protection, 
automatic fill-out field advance, calculations, validations, field specific help, non-printable on-
screen clues, etc. The Eform is usually designed to emulate the paper form it replaces exactly. 
The user of an Eform simply fills it out according to the guidelines and rules set down by the 
Eforms designer. After the typical Eform is filled out/in the user can save it to file, send it via 
email, etc. or print a hard copy to blank paper or pre-printed forms. When printing to pre-printed 
forms, only the data entered is printed. In summary, an Eform is somewhat similar to Email, but 
an Eforms processor is quite differnt from a word processor, spreadsheet, etc. While EZ-Forms 
has some of the functionality of the above, it is uniquely suited to processing forms."



What's New
For EZ-Forms

* New features in release 97f include:
* 32 Bit Release for Windows 95 and NT.

Win3.1x requires Win32s be installed first.
* Shorter default field names.

The eight character default name 'field001' is reduced to four characters as 'f001'.
* Calculation field Auto-Passthrough.

No need to press Enter for calculated fields such as subtotal and tax fields.
* Field definitions export to text file.

Print/View ASCII    text file of Field Setup data for Option, Pick List, Help, Validation and 
Calculation tabs.

* Progress Bar during form load and save.
Progress Bar lets you know that the program is doing something during load/save of large 
forms.

* Incresed maximum length available for calculations.
Add a long column, nest several IIF() statements, more character spaces available for your 
calculations.

* Do not allow overwrite of FRM master form when saving FOM/FOF fillout mode files.
Prevents accidentally selecting Edit-Fillout and double-clicking the master form, causing you 

to loose hours of work.
* When linked BMP not found, search in current work directory and EXE directory before asking 
user for its location.

Reduce the size of forms by linking image files that can be shared from several workstations.

* Previous new features include:
* Increased voice technical support to one year. Unlimited for email.
* Data Import and Export. (Quote Delimited, 1 file per fill-out.)
* File-Open with .BMP/.DIB image file types - creates a new form and loads the image.
* Margins warning at print time for orientation or form size to large to fit on designated paper 
size.
* "Trace" mode (grey-out) for non-printable black-on-white scanned or imported images.
* New Command line options - Data Import, Data Export, Print, Exit.
* Vertical character position follows screen view and printout more accurately on large monitors.
* Improved WYSIWYG with more video and printer drivers.
* Improved color rendition on images with higher resolution than local video.
* Numerous touch-ups.
* Multiple pages per form files with:

- Collated & Non-collated print options
- Next Page / Previous Page Toolbar buttons
- Insert Page / Delete Page menu options
- Page number in Status Bar

* Print Field Data Only - for use with pre-printed forms.
* Highlighted background (color is user adjustable) of any
    text or data input field.
* Auto-Popup field Help & Picklist ... Global setting or Individual fields.
* Tips of the Day quick access screen.
* Select and move multiple field names simultaneously in Fillout Order dialog box.



* New installation process using InstallShield.

* New features in release 96cb/2.11 include:
* Direct TWAIN compliant scanner support.
* Full text justification option.
* Full zero suppression on calculated numeric fields.
* The ability to import any device independent bitmap
    from Window's clipboard.
* The ability to link graphic files to your forms (rather
    than embedding them) to save precious disk space.
* Numerous touchups.
* Enhanced field operations including:
    -Field Calculations (50+ math & logical)
    -Ordering (the way the cursor moves)
    -Pick lists (for quick data entry)
    -User help (unique field help eases entry questions)
    -Validation (imposes data entry limits)
    -Auto-date/time/number, etc.
* Multiple object selection for move, copy, paste, etc.
* Built-in support for MAPI (mail application programming interface)
    compatible Email (Electronic Mail).
* Support for international measurements and paper sizes. 
    Window's international settings are monitored and the appropriate defaults 
    are used. (ISO paper sizes and metric measurements, for instance)
* Unlimited character size for text objects. (Old limit was 256 characters.)
* Improved OLE functionality.
* Multiple copy printing.
* Graphics placement/sizing is faster via use of screen tokens.
* Screen updates are faster too.
* Immediate TD enhancement capability.
* EZ-Forms can save thousands of dollars in
    pre-printed forms and time, but ...

For EZ-Forms
NOTE: The EZ-Forms™ (XL, PRO, ODBC) product line for Windows 
was previously named the FormPower™ series.      ( FormPower/PRO, 
HotForms/PRO, FormEZ, FormIT, SuperForms )
For more information, contact EZX Corporation at +1-281-280-9900    
FAX: +1-281-280-0099.

FormPower PRO Version 2.1 Release 96c - Released March 1996

See Also
• TWAIN-compliant scanner support via File-Scanner commands - allows FormPower 
PRO to directly import pre-printed forms or images. Import your most often used forms, 
set the image to be non-printable, add data entry fields and save form.
• Edit-Insert Graphic and Edit-Change Graphic - BMP and DIB graphic files can now be directly 



utilized in a form without OLE overhead. This also applies to scanner-acquired images.
• Added Full Justification to Text attributes option.
• Added Full Zero Suppression to calculated numerical fields.
• Color correct display option added to the Options-Preferences All tab.
• Improved support for larger OLE images.

FormPower PRO Version 2.0 Release 95k - Released November 1995

“PRO” features include:
• Extensive on-line help and MANUAL with BROWSE, TEXT SEARCH and PRINT. FPP Help's 
powerful features (not available in “regular” Windows help files) will allow you to find any topic or
phrase quickly. You will also be able to print any group of topics on demand. The unique “tree” 
structure gets you to your information fast. You'll NEVER be without your manual again!
• Calculations - robust and “better than a spreadsheet”. 50+ field-oriented mathematical and 
logical functions are supported.
• Field Types: Character, Numeric, Date or Logical.
• Automatic field options include: Number (great for incrementing invoices, reports, etc.), Date, 
Time, Calculated and Remember. Override enable/disable is available too.
• Numeric field formatting with selectable number of visible digits and leading/trailing zero 
suppression.
• Field Pick Lists allow annotated data entry selections for real “no brainer” fill-out/in.
• Field Help allows the forms designer to input custom help for each field of the form - kind of 
like having the expert looking over the filler's shoulder.
• Field Validation assures proper data entry. Override (with customizable error message) is 
allowable if there are errors.
• Built-in support for MAPI (mail application programming interface) compatible E-mail 
(Electronic Mail).
• Enhanced dialog boxes with Tab select groups.
• Multiple Object Selection for fast movement and duplication of entire groups of objects.

New features in Version 1.30 Release 95h include:
• Support for international measurements and paper sizes.
    Window's international settings are monitored and the appropriate defaults 
    are used. (ISO paper sizes and metric measurements, for instance)
• Unlimited character size for text objects. (Old limit was 256 characters.)
• Improved OLE functionality.
• Date and Time feed.
• Multiple copy printing.
• Graphics placement/sizing is faster.



Draw Menu commands
The Draw menu offers the following commands:

Line Draw lines vertically, horizontally, or angled.
Rectangle Draw squares or rectangular shapes.

RoundRect Draw squared and rectangular shapes with 
rounded corners.

Ellipse Draw circles or stretch the circle to any horizontal
or vertical length. A stretched circle is an ellipse.

Text Create a text object within the form.
Field Add data entry fields in specific locations on the 

form.
Select Enables Select drawing mode.



Edit menu commands (Design Mode)
The Edit menu offers the following commands:

Select Enables Select drawing mode.
Cut Deletes data from the form and moves it to the 

clipboard.
Copy Copies data from the form to the clipboard.
Paste Pastes data from the clipboard into the form.

Delete Removes the currently selected text or object.
Text Edit selected text object.

Undo Restores the last deleted text or object.
Insert Graphic Import and existing BMP or DIB file.

Change Graphic Replace current image.
Insert New 

Object
Insert an OLE object into the form.

OLE Links List and edit links to embedded documents.
Object verb Menu selection varies depending on highlighted 

object.
Fillout Fillout data fields in the current form

Text Feed-Time Place today's date into fillout field in form
Text Feed-Date Place current time into fillout field in form

Clear All Clears all text or all objects.
Select All Multi-Object manipulation.



Edit menu commands (Fillout Mode)
The Edit menu offers the following commands:

Cut Deletes data from the form and moves it to the 
clipboard.

Copy Copies data from the form to the clipboard.
Paste Pastes data from the clipboard into the form.

Delete Removes the currently selected text or object.
Undo Restores the last deleted text or object.

Object verb Menu selection varies depending on highlighted 
object.

Fillout Next Fill out a series of forms, all based on the same 
master form template

Text Feed-Time Place today's date into fillout field in form
Text Feed-Date Place current time into fillout field in form

Clear All Clears all text or all objects.



Field menu commands
The Field menu offers the following commands:

Pick Choose current field contents from a list
Help Display help for current field

Calculate Re/calculate current field contents
Validate Re/validate field contents

Date Place today's date into fillout field in form
Time Place current time into fillout field in form

Recalc All Recalculate all formulas in the form.



File menu commands (Design Mode)
The File menu offers the following commands:

New Creates a new form.
Open Opens an existing form.
Fillout Fillout a form that contains data entry fields.
Close Closes the active form window.
Save Saves an opened form using the same file name.

Save As Saves an opened form to a specified file name.
Save All Saves all modified forms that have not yet been 

saved to disk.
Send Mail Send a message via the resident email system.

Scanner-Acquire Scanner an image into the current form.
Scanner-Select 

Source
Select the TWAIN-compliant device for acquiring 
images.

Print Prints a form.
Print Preview Displays the form on the screen as it would 

appear printed.
Print Setup Selects a printer and printer connection.

File 1, 2, 3, 4 List of the four most recently opened forms.
Exit Exits EZ-Forms.



File menu commands (Fillout Mode)
The File menu offers the following commands:

New Creates a new form.
Open Opens an existing form.
Fillout Fillout a form that contains data entry fields.
Close Closes the active form window.
Save Saves an opened form using the same file name.

Save As Saves an opened form to a specified file name.
Save All Saves all modified forms that have not yet been 

saved to disk.
Send Mail Send a message via the resident email system.

Import Import delimited ASCII data into the form.
Export Export form data to a delimited ASCII format.

Print Prints a form.
Print Fields For use with pre-printed forms.

Print Preview Displays the form on the screen as it would 
appear printed.

Print Setup Selects a printer and printer connection.
File 1, 2, 3, 4 List of the four most recently opened forms.

Exit Exits EZ-Forms.



Form menu commands
With an object is selected, the Form pulldown menu will allow changes to that particular object 
only. Modifications do not affect any of the other objects on the form. Grid and Form Layout 
options apply on a form-wide basis.

Field Setup Set up fillout parameters for selected field
Text Text margins, justification, etc.
Font Font name, size, etc.
Pen Line/border type and thickness.

Brush Rectangle, RoundRect, and Ellipse backgrounds.
Printable Printed or Non-Printed object.
To Front Places object into foreground.
To Back Places object into background.

Insert Page
Delete Page

Grid Spacing, ON-OFF, Snap to
Fillout Order Setup fillout order of fields
Form Layout Adjust form output size.



Help menu commands
The Help menu offers the following commands, which provide you assistance with EZ-Forms:

Contents Displays the help Table of Contents.
Overview Displays a quick overview.

Using Help Provides general instructions on using help.
Tip of the Day Helpful tips and suggestions

About Displays the version number.



Options menu commands
The Options menu offers the following commands which enable you to set default operating 
parameters for various features of EZ-Forms.

Defaults-Text Attributes, color
Defaults-Font Font, size, attributes, color
Defaults-Pen Thickness, style, color

Defaults-Brush Style, color
Defaults-Printable Toggle On-OFF

Defaults-Grid Spacing, ON-OFF, Snap to
Defaults-Form Layout Adjust form output size.

Preferences Program features.
Save Settings Saves settings after adjusting program 

defaults



View menu commands
The View menu offers the following commands:
View Scaling commands:

100 % View at full size..
75 % View at 75% of full size.
50 % View at 50% of full size.

200 % View at twice full size.
Custom % User definable view scale.
Custom % User definable view scale.

Go To Page Navigating multi-page forms
Refresh Updates the screen.



Window menu commands
The Window menu offers the following commands, which enable you to arrange multiple form 
windows within the main EZ-Forms program window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.

Arrange Icons Arranges icons of minimized windows.
Close All Close all opened form widows.

Window 1,2, ... Activates specified window.



Each form window title bar indicates the name of the open form in a highlighted color that is 
different from any other open form window.



An icon within the EZ-Forms client area (window) indicates an open form that has been 
minimized to clear the work space. The name of the opened form file is displayed below the icon
symbol. Several opened forms may be iconized at once in order to clean up the form display 
area. Double-click on the icon to bring the form back into the foreground and make it the active 
window.



Form design (Master Form) and data entry (Fillout Form) work area.



A handle is a small black square on the end point, corner point or edge of a selected object. A 
handle represents possible resizing points. When the mouse cursor is on any handle, the cursor
changes shape to represent the possible resizing that could take place via mouse click and drag
movement.



Horizontal Scroll bars

Horizontal Scroll bars are positioned at the bottom. Scroll bars are displayed at the right and 
bottom edges of the form window when the form exceeds the size of that window. The scroll 
boxes inside the scroll bars indicate your vertical and horizontal view of the form. You can use 
the mouse to bring other parts of the form into view.



An Inactive form does not have a highlighted title bar. Click on any visible part of the form to 
make it the active form. Select the Window pulldown menu for a list of open form file windows.



Maximize button

Use this button to enlarge the active window to fill available space. A form window Maximize 
button will expand its window to the size of the EZ-Forms main window, and set it to be the 
active window. The main window Maximize button will expand the EZ-Forms main window to fill 
the entire screen.

Shortcut
Mouse:

Click the maximize icon  on the title bar, or double-click the title bar.
Keys: Ctrl + F10 enlarges active form window.



Minimize button

In the main window, use this command to reduce the EZ-Forms window to an icon. The 
Minimize button of a form window will iconize the active form window and display the icon within
the main window (client area).

Shortcut

Mouse: Click the minimize icon  on the title bar.



Modify the selected object to a different file type using an external program.



The program's window Title bar displays the name of the program and the name of the active 
open form window.

The Form window Title bar indicates the name of the form. If the form is active, the title bar is 
highlighted.



Window Size

Size command (Control menu)

Use this command to display a four-headed arrow so you can size the active 
window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the 
pointer to the border you want to move.

2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable when the window is maximized.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Vertical Scroll bars

Vertical Scroll bars are positioned on the right side. Scroll bars are displayed at the right and 
bottom edges of the form window when the form exceeds the size of that window. The scroll 
boxes inside the scroll bars indicate your vertical and horizontal view of the form. You can use 
the mouse to bring other parts of the form into view.



Title Bar

The title bar is located along the top of a window. It contains the name of the application and the
active form.

To move the window, drag the title bar to the desired position.

Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
• Application Control menu button
• Form Control menu button
• Maximize button
• Minimize button
• Name of the application
• Name of the form
• Restore button



The EZ-Forms program mode that allows creation and modification of Master Forms.



A EZ-Forms feature that creates objects. To place an object, first select a drawing tool, then 
position the mouse pointer to where the top leftmost point of the object will be and press the left 
mouse button. Then continue to hold the left mouse button and drag the mouse pointer to the 
bottom rightmost point of the object. Finally, release the left mouse button. If snap-to-grid is on, 
the object's end points will automatically move to the nearest grid points.



An expression is a mathematical formula used for field calculations and validations. It is a 
combination of field names, operators, functions and constants that evaluates to a Logical, 
Character, Numeric or Date type. See Expressions for more information.



A specific type of form, created with EZ-Forms from a Master Form. A unique Fillout Form file 
exists for each form that is filled out. All Fillout Form files have an extension of .FOF.



The EZ-Forms program mode that allows creation and modification of Fillout Forms.



A format contained in a file, which specifies how data is to be presented on the screen or printer.
Forms can contain data fields, fixed text, printing attributes and graphics.



A specific type of form created by EZ-Forms in design mode. A Master Form represents a blank 
form, to be copied and filled out time and time again. All Master Form files have an extension 
of .FRM.



The basic unit of a form. An object is created by a drawing tool in design mode, and is saved 
into a Master Form. Objects have attributes, and can be modified in various ways.



OLE is an acronym for Object Linking and Embedding. In short, OLE allows an object created 
by an OLE server (such as Paint, Excel, etc.) to be embedded into an OLE client application, in 
this case EZ-Forms. This very powerful feature allows placement of graphics, sound, video or 
other objects onto a EZ-Forms form.



In design mode only, to access this menu move the mouse pointer over an object and click the 
right mouse button. Continue to hold the button until you make a selection from the menu.






